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Radio and Television Interference

This equipment has been tested and found to comply with CISPR EN55022 Class A and
EN61000-6-1 requirements and also with the limits for a Class A digital device, pursuant to
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and
used in accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause harmful
interference, in which case the user will be required to correct the interference at his own
expense.

Changes or modifications to this equipment not expressly approved by Data Translation could
void your authority to operate the equipment under Part 15 of the FCC Rules.

Note: This product was verified to meet FCC requirements under test conditions that
included use of shielded cables and connectors between system components. It is important
that you use shielded cables and connectors to reduce the possibility of causing interference
to radio, television, and other electronic devices.

Canadian Department of Communications Statement

This digital apparatus does not exceed the Class A limits for radio noise emissions from
digital apparatus set out in the Radio Interference Regulations of the Canadian Department of
Communications.

Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites
applicables aux appareils numériques de la class A prescrites dans le Réglement sur le
brouillage radioélectrique édicté par le Ministere des Communications du Canada.
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About this Manual

The first part of this manual describes how to install and set up your DT8837 instrument
module, and verify that the DT8837 is working properly.

The second part of this manual describes the features and capabilities of the DT8837 using the
IVI-COM instrument module driver software. Troubleshooting information is also provided.

Note: If you are programming the instrument module using the IVI-COM driver, refer to the
DT8837 IVI-COM driver online help for more information.

If you are using Standard Commands for Programmable Instruments (SCPI) to program your
instrument module, refer to the SCPI Programmer’s Manual for the DT8837 for more
information.

Intended Audience

This document is intended for engineers, scientists, technicians, or others responsible for
using and/or programming the DT8837 instrument module for data acquisition operations. It
is assumed that you have some familiarity with data acquisition principles and that you
understand your application.

How this Manual is Organized

This manual is organized as follows:

® Chapter 1, “Overview,” describes the major features of the DT8837 instrument module, as
well as the supported software and accessories for the instrument module.

e Chapter 2, “Preparing to Use the DT8837,” describes how to unpack the instrument
module, check the system requirements, install the DT8837 software, and view the
DT8837 documentation online.

® Chapter 3, “Setting Up and Installing the Instrument Module,” describes how to install
the DT8837 instrument module, how to apply power to the instrument module, and
connect the DT8837 to the network.

e Chapter 4, “Wiring Signals,” describes how to wire signals to the DT8837 instrument
module.

® Chapter 5, “Verifying the Operation of an Instrument Module,” describes how to verify
the operation of the DT8837 instrument module.

® Chapter 6, “Principles of Operation,” describes all of the features of the DT8837
instrument module in detail.

e Chapter 7, “Using the VIBpoint Framework Application,” describes how to use the
VIBpoint Framework application with a DT8837 instrument module.
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¢ Chapter 8, “Troubleshooting,” provides information that you can use to resolve problems
with the DT8837 instrument module and device driver, should they occur.

® Chapter 9, “Calibration,” describes how to calibrate the analog I/O circuitry of the
DT8837 instrument module.

e Appendix A, “Specifications,” lists the specifications of the DT8837 instrument module.

e Appendix B, “Connector Pin Assignments,” lists the pins for each of the connectors on the
DT8837 instrument module.

* Appendix C, “Configuring Network Settings on Your PC,” describes how to configure the
network settings of your PC to use Auto-IP or a static IP address.

¢ Anindex completes this manual.

Conventions Used in this Manual

The following conventions are used in this manual:

¢ Notes provide useful information or information that requires special emphasis, cautions
provide information to help you avoid losing data or damaging your equipment, and
warnings provide information to help you avoid catastrophic damage to yourself or your
equipment.

* Jtems that you select or type are shown in bold.

Related Information

Refer to the following documents for more information on using the DT8837 instrument
module:

¢ DT8837 IVI-COM Driver online help. For programmers who are developing their own
application programs using a tool other than Measure Foundry, this document describes
how to use the IVI-COM driver to access the capabilities of the DT8837 instrument
module. The DT8837 IVI-COM driver works with any development environment that
supports COM programming, including MATLAB® from The MathWorks™, Microsoft®
Visual C#®.NET or Visual Basic®.NET, Agilent® VEE Pro, National Instruments™
LabVIEW™ or LabWindows™, and so on.

® SCPI Programmer’s Manual for the DT8837(UUM-23333). For programmers who want to use
the SCPI interface to program DT8837 instrument modules, this document describes the
supported SCPI commands and example programs for the DT8837 instrument module.

¢ IVIfoundation (www.ivifoundation.org)

¢ LXI Consortium (www.lxistandard.org)

Where To Get Help

Should you run into problems installing or using a DT8837 instrument module, the Data
Translation Technical Support Department is available to provide technical assistance. Refer
to Chapter 8 for more information. If you are outside the United States or Canada, call your
local distributor, whose number is listed on our web site (www.datatranslation.com).

10
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DT8837 Hardware Features

The DT8837 instrument module is a high-performance, multifunction data acquisition device
for the Ethernet (LXI) bus. It is a class C device and complies with LXI version 1.1.

The DT8837 is part of the VIBpoint family of precision measurement devices for vibration data
acquisition, analysis, and monitoring. The VIBpoint-DT8837 packages four DT8837
instrument modules with the VIBpoint Framework application and three Trigger Bus cables
for synchronizing up to 16 analog input channels.

The key hardware features of the DT8837 instrument module are as follows:

* Simultaneous analog input and waveform analog output operations

® ISO-Channel™ protection eliminates noise and ground loops

+500 V galvanic isolation channel-to-channel on all input/output signals and to the
host computer to protect signal integrity

* Analog input subsystem:

Four, simultaneous 24-bit A /D converters

Throughput rate up to 52.734 kSamples /s for simultaneous, high-resolution
measurements

Input range of 10 V with software-selectable gains of 1 and 10 for an effective input
range of £10 V and +1 V

Support for IEPE (Integrated Electronic Piezoelectric) inputs, including use of a 4 mA
current source with 24 V compliance voltage, and AC or DC coupling

The ability to return the value of the tachometer in the analog input data stream,
allowing you to measure the period or frequency of the tachometer input signal
synchronously with analog input measurements

The ability to return the value of the counter/timer channels in the analog input data
stream, allowing you to measure the period or frequency of the tachometer and/or
gate input signal synchronously with analog input measurements

The ability to measure the analog input sample to the tachometer or gate input or the
tachometer or gate input to the analog input sample to correlate analog data with an
external event

Support for reading analog output values in the analog input data stream, allowing
you to correlate input and output values

Software-programmable trigger type (software, external digital trigger, analog
threshold trigger, or Trigger Bus trigger) to start the analog input operation. You can
also program the analog input threshold value.

* Analog output subsystem:

One 24-bit D/ A converter
Single value and waveform output mode

Programmable output rate from 10 kSamples/s to 52.734 kSamples/s
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— Output range of £10 V

— You can select a software trigger, external digital trigger, analog threshold trigger, or
Trigger Bus trigger to start the analog output operation

Common 48 MHz reference clock used to create the individual master clocks (which
determine actual sample rates) for the analog input and analog output subsystems

One digital output port, consisting of 4 isolated digital output lines

13
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Supported Software

The following software is available for use with the DT8837 instrument module:

Eureka Discovery Utility — This utility helps you locate or "discover" all LXI (Ethernet)
instruments that are connected to your system and provides the following information
about your instrument: the IP address, manufacturer, model number, serial number, and
version of the firmware that is running on your instrument. In addition, you can use this
utility to configure Windows firewall settings and update the firmware for your Data
Translation LXI instrument.

Instrument Module Web Interface — This built-in interface, described in Chapter 5,
allows you to verify the operation of your DT8837 instrument module and perform basic
functions with Internet Explorer and no additional software. Using it, you can configure
your instrument module, control output signals, measure input signals, and save results
to disk.

VIBpoint Framework application — A 14-day trial version of this application is shipped
with the DT8837 instrument module. This application, described in Chapter 7, lets you do
the following:

— Discover and select available DT8837 instrument modules
— Configure your DT8837 instrument module
— Acquire data from multiple instrument modules

— On each instrument module, acquire data from all channels on one instrument
module, or across multiple instrument modules that are synchronized using the
Trigger Bus

— Display acquired data during acquisition
— Perform FFTs (Fast Fourier Transforms) on the acquired analog input data

— Use a chart recorder to display snapshot or snapshots of data and log it to disk for later
analysis

— Use the channel overview to view data from your instrument module as a digital
display

DT8837 IVI-COM driver — This driver provides access to the DT8837 instrument module
functions through a COM server. The IVI-COM driver works in any development
environment that supports COM programming, including Measure Foundry, MATLAB,
Visual Basic.NET, Visual C#NET, Agilent VEE Pro, LabVIEW, LabWindows, and others.

SCPI commands — Use SCPI commands to program DT8837 LXI instrument modules.
Refer to the SCPI Programmer’s Manual for the DT8837 (UM-23333) for information on the
supported SCPI commands and example programs.

Refer to the Data Translation web site (www.datatranslation.com) for information about
selecting the right software package for your needs.
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Accessories

The following optional accessories are available for the DT8837 instrument module:

STP8837 DIN Rail Mountable Screw Terminal Panel (includes EP378 cable)
EP377 Trigger Bus cables (25-pin, .5M)
EP380 Single Rack-mount kit —To rack mount a single DT8837 instrument module.

EP379 Dual Rack-mount kit — To rack mount two DT8837 instrument modules side by
side.

15
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Getting Started Procedure

The flow diagram shown in Figure 1 illustrates the steps needed to get started using the
DT8837 instrument module. This diagram is repeated in each Getting Started chapter; the
shaded area in the diagram shows you where you are in the getting started procedure.

Prepare to Use the DT8837
(see Chapter 2 starting on page 19

Set Up and Install the DT8837
(see Chapter 3 starting on page 25)

Wire Signals
(see Chapter 4 starting on page 35)

Verify the Operation of the DT8837
(see Chapter 5 starting on page 45)

Figure 1: Getting Started Flow Diagram

16
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Prepare to Use the DT8837
(see this chapter)

Set Up and Install the DT8837
(see Chapter 3 starting on page 25)

Wire Signals
(see Chapter 4 starting on page 35)

Verify the Operation of the DT8837
(see Chapter 5 starting on page 45)




Preparing to Use the DT8837

Unpacking

Open the shipping box and verify that the following items are present:
¢ DT8837 instrument module

EP372 Ethernet cable

EP361 +5V power supply and cable
¢ Trigger Bus Terminators

DT8837 CD-ROM

If an item is missing or damaged, contact Data Translation. If you are in the United States, call
the Customer Service Department at (508) 481-3700, ext. 1323. An application engineer will
guide you through the appropriate steps for replacing missing or damaged items. If you are
located outside the United States, call your local distributor, listed on Data Translation’s web
site (www.datatranslation.com).

Once you have unpacked your DT8837 instrument module, check the system requirements, as
described in the next section.

21
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Checking the System Requirements

For reliable operation, the computer that accesses your DT8837 instrument module requires
the following configuration:

PC with Pentium 4 or equivalent processor

Screen resolution of 1024 x 768 (or higher)

1 GB of RAM recommended

1.5 GB of hard disk space

Ethernet port

CD-ROM drive

Administrator privileges for software installation

For access to the instrument module web interface:

— Java Version 6, Update 5 or greater

— Internet Explorer web browser, preferably version 8.0

Refer to page 47 for more information on installing Java and configuring your browser
settings

Acrobat Reader 5.0 or later for viewing documentation

Once you have verified that your system meets the system requirements, install the software,
as described in the next section.
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Installing the Software

This section describes how to install the software you need to use the DT8837 instrument
module.

Prerequisite Software

No prerequisite software is required if you are using a single client to access the DT8837
instrument module on the LXI bus, or if you are managing how multiple clients concurrently
access a DT8837 instrument module on the LXI bus. (In these cases, your application can use
sockets to communicate with the DT8837 instrument module.)

If, however, you want multiple clients to access the DT8837 instrument module on the LXI
bus, and you want to "lock" access to the instrument module so that one client cannot change
the configuration of the instrument module that another client is accessing, you need to install
VISA; we recommend either Agilent VISA or NI-VISA from National Instruments. You can
then use the VISA methods viLock/viUnlock to prevent other clients from accessing the
instrument module.

To install Agilent VISA, do the following;:

1. Go to www.agilent.com, enter IO Libraries Suite in the search field, and select Agilent
IO Libraries Suite 15.0 from the search results.

2. Follow the instructions on Agilent’s web site to download and install the Agilent IO
Libraries, which include VISA support, VISA COM support, and the Agilent Connection
Expert tool.

We recommend that you run Data Translation’s Eureka Discovery Utility that is provided with
the DT8837 software to locate your DT8837 LXI instrument module on the network (see page
51 for more information).

Installing the DT8837 Software

To install the DT8837 software (including the VIBpoint Framework application, DT8837
IVI-COM driver, Eureka Discovery Utility, DT8837 SCPI Support, and DT8837 Calibration
Utility) and related documentation, perform the following steps:

1. Insert the DT8837 CD into your CD-ROM or DVD drive.
The installation program should automatically start, and the DT8837 installation program should
appeatr.

2. If the installation program does not automatically start, double-click Setup.exe from the
CD.
The DT8837 installation program appears.

3. Click Install from Web (recommended) to get the latest version of the software or Install
from CD to install the software from the CD.

4. If you are installing from the web, click DT8837 Software to install the DT8837 software.

5. If you are installing from the DT8837 CD, click Install Features. When you are finished
with the DT8837 CD, click Quit Installer.

23
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Viewing the Documentation

Note: To view the documentation, you must have Adobe Reader 5.0 or greater installed on
your system.

You can access the documentation for your DT8837 instrument module from the Windows
Start menu as follows:

For documentation about the DT8837, click Programs -> Data Translation, Inc ->
Instruments -> DT8837 -> DT8837 User’s Manual.

For documentation on the DT8837 IVI-COM driver, click Programs -> Data Translation,
Inc -> Instruments -> DT8837 IVI Support -> Documentation.

For documentation on the Eureka Discovery Utility, click Programs -> Data Translation,
Inc -> Instrument Support -> Eureka LXI Instrument Discovery.

For documentation about SCPI support for the DT8837, click Programs -> Data
Translation, Inc -> Instruments -> DT8837 -> DT8837 SCPI Support.

The following may be helpful when using Adobe Reader:

To navigate to a specific section of the document, click a heading from the table of
contents on the left side of the document.

Within the document, click the text shown in blue to jump to the appropriate reference
(the pointer changes from a hand to an index finger).

To go back to the page from which the jump was made, click the right mouse button and
Go Back, or from the main menu, click Document, and then Go Back.

To increase or decrease the size of the displayed document, from the main menu, click
View, and then Zoom.

By default, Adobe Reader smooths text and monochrome images, sometimes resulting in
blurry images. If you wish, you can turn smoothing off by clicking File, and then
Preferences/General, and unchecking Smooth Text and Images.
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Prepare to Use the DT8837
(see Chapter 2 starting on page 19

Set Up and Install the DT8837
(see this chapter)

Wire Signals
(see Chapter 4 starting on page 35)

Verify the Operation of the DT8837
(see Chapter 5 starting on page 45)




Setting Up and Installing the Instrument Module

Connecting the DT8837 to the LAN

This section describes how to connect the DT8837 instrument module to the LAN (Local Area
Network). Two connection schemes are shown:

¢ Site LAN connections, described on this page

® Private LAN connections, described on page 41

Note: Itis recommended that you consult with your network administrator to ensure that
all network security, performance, and reliability issues are considered when using
connecting DT8837 instrument modules to the LAN.

Connecting to a Site LAN

A site LAN is useful in applications that require access by many users or access by users at
distributed sites. In this connection scheme, a DHCP (Dynamic Host Configuration Protocol)
server is used to assign an IP address to the DT8837 instrument module.

Figure 2 shows a typical site LAN connections using a dedicated Ethernet hub, switch, or
router. Figure 3 shows typical site LAN connections without using a dedicated Ethernet hub,
switch, or router.

Note: Use standard LAN cables for network connections. The DT8837 instrument module
ships with a standard LAN cable (EP372) for connecting to the LAN (R]45) connector on the
rear panel of the DT8837 instrument module.

Computer Ethernet
Hub/ Switch/ Router

— | ]

To Site LAN

= = h O\D — = n O\D — = h O\EI — = o O\EI
DT8837 DT8837 DT8837 DT8837
+5 V Power +5 V Power +5 V Power +5 V Power
Supply Supply Supply Supply

Figure 2: Typical Site LAN Connections using a Hub, Switch, or Router

27



Chapter 3

To Site LAN
Computer To Site LAN
DT8837
+5 V Power
Supply

Figure 3: Typical Site LAN Connections Without Using a Hub, Switch, or Router

Connecting to a Private LAN

A private LAN (or subnet) generally involves the direct connection of the instrument modules
to the computer, and may include Ethernet hubs or switches. Access to the instrument
modules is limited to users that are directly connected to the private LAN; therefore, security,
performance, and reliably are generally better on a private LAN than on a site LAN.

In this connection scheme, the DHCP (Dynamic Host Configuration Protocol) server is
typically not available; therefore, Auto-IP is used to assign an IP address to the DT8837
instrument module.

Note: If no DHCP server exists and your PC is set up to use a static IP address, you must
temporarily reconfigure your PC to use Auto-IP, as described in Appendix C on page 144.

Connecting Using a Hub or Switch

Figure 4 shows a typical connection scheme when connecting DT8837 instrument modules to
a private LAN using a dedicated Ethernet hub or switch.

Note: Use standard LAN cables for network connections. The DT8837 instrument module
ships with a standard LAN cable (EP372) for connecting to the LAN (R]45) connector on the
rear panel of the DT8837 instrument module.

28
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Computer Ethernet

Hub/ Switch

— = M o~ — = h o~ — = h o~ — = o o[
DT8837 DT8837 DT8837 DT8837
+5 V Power +5 V Power +5 V Power +5 V Power
Supply Supply Supply Supply

Figure 4: Typical Private LAN Connections using a Hub or Switch

Connecting Directly to a Computer

Optionally, you can connect the DT8837 instrument module directly to your computer,
creating an ad hoc network, as shown in Figure 5. Be aware that the time and date settings of
the instrument module will not be updated using this connection method. Therefore, this
connection scheme is generally recommended for quick set up and verification only.

Note: DT8837 instrument modules do not support the Auto-MDIX function; therefore, use a
crossover cable rather than a standard LAN cable to connect your DT8837 instrument module
unless your computer has enabled the Auto-MDIX function.

Computer

i ] O\D
DT8837

Standard LAN Cable (if PC enabled Auto-MDIX)
or
Ethernet Crossover Cable (if PC doesn’t enable

Auto-MDIX or you are not sure) +5 V Power

Supply

Figure 5: Typical Private LAN Connections when Connecting Directly to a Computer
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Applying Power

The DT8837 instrument module is shipped with an EP361 +5V power supply and cable. To
apply power to the DT8837, do the following:

1. Connect the +5 V power supply to the power connector on the rear panel of the DT8837.

Refer to Figure 6.
DT8837 Rear Panel
Trig Bus
Input/Output — LAN  5vin Reset Power
(YA o -
D i
EP361 +5V
Power Supply
/ _-
To wall
outlet

Figure 6: Attaching a +5 V Power Supply to the DT8837 Instrument Module

2. Plug the power supply into a wall outlet.

3. Press the Power switch on the rear panel of the instrument module, shown in Figure 6, to
turn on the DT8837 instrument module.
The Power LED on the front panel lights to indicate that power is on.

Figure 7 shows the front panel of the DT8837, including the locations of the LEDs.

'DT8837

Ain Ch1 Ain Ch2 Ain Ch3 Ain Ch4 D/A Out

s o == / N\ y = N\ Tig

DATA TRANSLATION MI

Figure 7: Front Panel of the DT8837
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Getting an IP Address and Host Name

Once your DT8837 instrument module is connected to the LAN and powered on, the
instrument module automatically requests an Ethernet address from a DHCP (Dynamic Host
Configuration Protocol) server, if available, and a host name from a DNS (Dynamic Domain
Name Service) server, if available.

If these services are not available on the LAN, the DT8837 instrument module uses Auto-IP to
set up its TCP/IP configuration. In this case, the IP address will be in the range of 169.254.0.0
to 169.254.255.255 with a subnet mask of 255.255.0.0.

Note: If no DHCP server exists and your PC is set up to use a static IP address, you must
temporarily reconfigure your PC to use Auto-IP, then configure your DT8837 instrument
module to use a static IP address, as described in Appendix C on page 147.

You can use the instrument module’s web interface, described in Chapter 5 starting on page
45, to see the IP address and host name that is assigned to your DT8837 instrument module.

Notes: When programming a DT8837 instrument module, you access the instrument module
through its address string, which consists of an IP address or host name, such as
TCPIP0::192.43.218.69::inst0:INSTR or TCPIP0::192.43.218.69::SOCKET. If a host name was
returned by the DNS server, you can also address the instrument module using its host name,
such as TCPIPO::arrakis.datx.com::inst0: INSTR.

For IVI-COM programmers, you can also assign a VISA alias to the instrument module. For
example, rather than addressing the instrument module as
TCPIP0::192.43.218.69::inst0: INSTR, you can use the VISA alias DT8837_1 instead. See your
VISA documentation for more information on VISA resource strings and creating VISA
aliases.
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Determining Ethernet Activity

You can use the ENet Link and ENet Activity LEDs on the rear of the DT8837 instrument
module, shown in Figure 8, with the LAN LED on the front of the DT8837 instrument module,
shown in Figure 7, to determine the Ethernet activity on your DT8837 instrument module.
Table 1 describes the meaning of these LEDs.

DT8837

5Vin

ower
~

( )  Reset a0
= a1

DATATRANSLATION
e

Figure 8: Rear Panel of the DT8837

Table 1: Using DT8837 LEDs to Determine Ethernet Activity

LEDs Color Description
LAN LED Solid Green DT8837 instrument module has valid IP
(on front panel) address.

Blinking Green DT8837 instrument module identified using
the Web interface; see page 51 for more
information.

Red If the Ethernet link is operational, the
instrument module does not have a valid IP
address.

Otherwise, the Ethernet link is not

operational.
ENet Link LED Yellow Ethernet link operational.
(on rear panel)
Off Ethernet link not operational.
ENet Activity LED Green Network traffic detected.
(on rear panel) -
Off No network traffic detected.
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Resetting the Instrument Module

If needed, you can restore the default configuration of your DT8837 instrument module by
pressing the Reset pin on the rear panel of the instrument module, shown in Figure 8 on page
32, until the LAN LED on the front panel turns off (which takes approximately 5 seconds), and
then releasing the Reset pin.

The instrument module reboots automatically using the factory-default LAN configuration
(DHCP and auto-IP enabled); this process typically takes up to 40 seconds to complete. This
forces the instrument module to re-acquire an IP address from the DHCP server, or if that fails,
to use Auto-IP to get an IP address.

Note: The default configuration overwrites any changes that you have made to the LAN
configuration using the instrument module’s web interface.
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Wiring Signals

Preparing to Wire Signals

This section provides recommendations and information about wiring signals to the DT8837
instrument module.

Wiring Recommendations

Keep the following recommendations in mind when wiring signals to a DT8837 instrument
module:

¢ Follow standard ESD procedures when wiring signals to the instrument module.
e Separate power and signal lines by using physically different wiring paths or conduits.

¢ To avoid noise, do not locate the instrument module and cabling next to sources that
produce high electromagnetic fields, such as large electric motors, power lines, solenoids,
and electric arcs, unless the signals are enclosed in a mumetal shield.

¢ Prevent electrostatic discharge to the I/O while the instrument module is operational.

¢ Connect all unused analog input channels to analog ground.

Wiring Signals to the Instrument Module

The DT8837 instrument module contains five BNC connectors on one end of the instrument
module, and a 15-pin input/output connector, two 25-pin Trigger Bus connectors, and a LAN
connector on the other end of the instrument module as shown in Figure 9.

(] status LEDs Power Button

I

I: A/D Chan 1 Reset Pin O
— DT8837
o 5Vin
A/D Chan 2
o LAN
A/D Chan 3
_ Trigger Bus ]
A/D Chan 4
D/A Output Chan
_ Input/Output

(] status LEDs

Figure 9: Connectors of the DT8837

The remaining sections of this chapter describe how to attach signals to these connectors.
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Connecting Analog Input Signals

You can connect up to four analog input signals (or IEPE sensors) to the BNC connectors on
the DT8837 instrument module. Internally, these signals are connected in differential mode.
The DT8837 instrument module supports an input signal range of +10 V (using a gain of 1) or
+1 V (using a gain of 10).

Note: If you enable the use of the internal 4 mA excitation current source for IEPE inputs, it
is recommended that you choose AC coupling. Refer to page 102 for more information on
IEPE inputs.

Figure 10 shows how to connect analog inputs (channels 1 and 2, in this case) to the BNC
connectors on the DT8837 instrument module.

DT8837

Analog In 1

— > A/D Chan 1
Signal

Analog In 2
Source halog n

— |: A/D Chan 2

|:_ A/D Chan 3
|:_ A/D Chan 4

I: D/A Chan

Figure 10: Connecting Analog Inputs to the DT8837
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Connecting an Analog Output Signal

The DT8837 instrument module provides one analog output channel with an output range of
+10 V. Figure 11 shows how to connect an analog output signal to the DT8837 instrument

module.
DT8837
A/D Chan 1
A/D Chan 2
A/D Chan 3
A/D Chan 4
Analog Out 1 ]
Load
] D/A Chan

Note that the BNC automatically
connects the Analog Ground
signal appropriately.

Figure 11: Connecting an Analog Output Signal to the DT8837
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Connecting to the Input/Output Connector

To make I/O connections easier, you can use the optional STP8837 screw terminal panel and
EP378 cable with your DT8837 instrument module to connect the tachometer, gate, and digital
output signals to the DT8837 instrument module. Connect the STP8837 to the I/O connector
of the instrument as shown in Figure 12:

DT8837

Power Button

Reset Pin
5Vin
LAN
Trigger Bus :|
EP378 Cable Assembly
Input/Output
( STP8837

Figure 12: Connecting the Instrument Module to the STP8837

Figure 13 shows the layout of the STP8837 screw terminal panel and lists the assignments of
each screw terminal.
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I

Tachometer Input 1
Tachometer In Return 9
Trigger Input 2
Trigger In Return 10
Gate Input 3

Gate In Return 11

TB1

TB2

15

14

13

12

Digital Output 3B
Digital Output 3A
Digital Output 2B
Digital Output 2A
Digital Output 1B
Digital Output 1A
Digital Output 0B
Digital Output 0A

Figure 13: STP8837 Screw Terminal Panel

Connecting a Tachometer Input Signal

You can connect a tachometer input signal with a range of up to +30 V to the tachometer input
pins on the STP8837, as shown in Figure 14.

Note: In software, you can read tachometer measurements as part of the analog input
channel list. Refer to page 85 for more information on tachometer measurements.

Tachometer,|
Input

In

TB1

In Return

Figure 14: Connecting a Tachometer Input Signal to the STP8837

ORONONORON0)

10

1"
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Connecting a Gate Input Signal

You can connect a TTL gate input signal to the gate input pins on the STP8837, as shown in
Figure 15.

Note: In software, you can read gate measurements as part of the analog input channel list.
Refer to page 87 for more information on gate measurements.

TB1
&) 1
S 9
S 2
S 10
In
Gate S 3
Input Q 1
In Return

Figure 15: Connecting a Gate Input Signal to the STP8837
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Connecting Digital Output Signals

The isolated digital output lines of a DT8837 instrument module act as solid-state relays. The
customer-supplied signal can be +30 V at up to 400 mA (peak) AC or DC.

You can use the digital output lines of the instrument module to control solid-state or
mechanical relays or high-current electric motors. Figure 16 shows how to connect digital
output signals to line 0 of the instrument to control a motor relay.

Instrument Module Motor
Digital Output Connector

Relay

Controlled by

Software 10A
Fuse
pin 4 Digital Out 0 A
- D
‘*}D 5—‘ ~ Hot  Neutral
i - &5, 120 V AC
pin 12 Digital Out 0 B or 240 V AC

- +*
30V DC @ 400 mA
*Output can switch AC or DC.

Figure 16: Switching up to 30V at 400 mA
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Prepare to Use the DT8837
(see Chapter 2 starting on page 19

Set Up and Install the DT8837
(see Chapter 3 starting on page 25)

Wire Signals
(see Chapter 4 starting on page 35)

Verify the Operation of the DT8837
(see this chapter)

You can verify the operation of the DT8837 instrument module using the instrument module’s
web interface.

You can configure, measure, and control the DT8837 instrument module either locally or
remotely using this interface.

Alternatively, you can use the VIBpoint Framework application to configure the instrument
module and acquire data from the analog inputs, tachometer, counters, and analog output
readback channel, and perform FFIs on the analog input data. This chapter focuses on
verifying your instrument module using the web interface; refer to Chapter 7 starting on page
95 for information on using the VIBpoint Framework application.



Verifying the Operation of an Instrument Module

Before Using the Web Interface

This section describes system requirements and browser settings for proper operation of the
instrument module’s web interface.

Note: Atany instant, up to 8 clients can access the DT8837 instrument modules concurrently
using the web interface.

Up to 12 additional clients can access the DT8837 instrument modules concurrently using
SCPI commands over VISA or sockets. Of these, 4 can be VXI-11 clients, which use the
=:SOCKETS or VISA::INSTR resource to access the instrument module.

At this time, the web and SCPI interfaces cannot be "locked;" therefore, one client can change
the configuration of the instrument module that another client is accessing. However, you
can optionally lock the VXI-11 interface using the VISA APIs viLock/viUnlock; this prevents
other VXI-11 clients (including VXI-11 discovery) from accessing the instrument module.
Refer to the SCPI documentation for your instrument module for more information on
supported SCPI commands.

Java Requirements

Before using the instrument web interface, ensure that your computer has Version 6, Update 5
or greater of Java installed; this version of Java installs version 1.6 of the Java plug-in. You can
verify Java versions and settings by accessing the Java Control Panel, select Windows Start ->
Control Panel and open the Java dialog. To download or upgrade Java, go to www.java.com.

Internet Explorer Browser Settings
For proper operation of the instrument module’s web interface, ensure that your Internet
Explorer browser is configured as follows:
* JavaScript (Active Scripting) must be enabled

¢ Security level of the DT8837 instrument module IP address must be Medium-high or
lower

* Pop-up blockers must be disabled

The following sections describe how to configure these settings.

JavaScript

To enable JavaScript (also referred to as Active Scripting), perform the following steps:
1. From the Internet Explorer browser, select Tools -> Internet Options.
2. Click the Security tab.

3. Select Internet, and then click Custom Level.
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4. Scroll down to the Scripting section.

Settings:

Scripting

Active scripting
Disable
Enable
Prompt

5. Under Active Scripting, select Enable, and then click OK.

Security Levels

By default, the IP address of the DT8837 instrument module is added to the Internet zone. If
you'd rather leave the settings of the Internet zone at a level higher than Medium-high, then
you can add the IP address of the DT8837 to either the Local intranet or Trusted sites zone and
configure the security level of that zone to Medium-high or lower.

The following section describe how to configure each zone.

Internet Zone

To configure the security level of the DT8837 instrument module’s IP address in the Internet
zone, perform the following steps:

1. From the Internet Explorer browser, select Tools -> Internet Options.

2. Click the Security tab.

Internet Options

Geneml| Security |F‘ri\racy Content | Connections | Programs | Advanced

Select 8 Web content zone to specify its security settings.

® Q@ 0 Q9

Intemet Localintranet  Trusted sites  Restricted
sites

Internet

This zone contains all Web sites you
havent placed in other zones

Security level for this zone
Move the slider to set the security level for this zone.
| Medium
- Safe browsing and still functional

- Prompts before downloading potentially unsafe content
- Unsigned ActiveX controls will not be downloaded
- Appropriate for most Intemet sites

[ ok [ cancel J[ emty |

3. Select Internet and move the slide bar to select a security level of Medium-high or lower.

4. Click OK.



Verifying the Operation of an Instrument Module

Local Intranet Zone

To add the IP address of the DT8837 to the Local intranet zone and configure its security level,
do the following;:

1. From the Internet Explorer browser, select Tools -> Internet Options.

. Click the Security tab.

2

3. Click Local intranet, and click Sites.

4. Select which web sites to add to the zone, and then click Advanced.
5

. Enter the IP address of the DT8837 instrument module to the zone, and click Add.

Local intranet

";' You can add and remove Web sites from this zone. All Web sites
¥ in this zone will use the zone's security settings.

Add this Web site to the zone:

Web sites:

[Irequire server verification (https:) for all sites in this zone

[ oK ] [ Cancel

6. Click OK.
7. Move the slide bar to select a security level of Medium-high or lower.

8. Click OK.

Trusted Sites Zone

To add the IP address of the DT8837 to the Trusted sites zone and configure its security level,
do the following;:

1. From the Internet Explorer browser, select Tools -> Internet Options.
2. Click the Security tab.

3. Click Trusted sites, and click Sites.

4

. Enter the IP address of the DT8837 instrument module to the zone (note that the address
must be prefaced by (https:/ /), and click Add.
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Trusted sites

You can add and remove Web sites from this zone. All Web sites
in this zone will use the zone's security settings.

Add this Web site to the zone:
[ https://192.43.218.69 | [ add

Web sites:

Require server verification (https:) for all sites in this zone

[ oK ] [ Cancel

5. Click OK.

6. Click Default Level, and move the slide bar to select a security level of Medium-high or
lower.

7. Click OK.
Pop-up Blockers

To disable pop-up blockers, perform the following steps:
a. From the Internet Explorer browser, select Tools ->Pop-up Blocker.

b. Select Turn Off Pop-up Blocker.
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Locating Your Instrument Module on the LAN

To access the web interface of your instrument module, you must determine its IP address on
your TCP/IP network.

Note: Discovery will work only for devices on the same subnet.

We recommend that you run Data Translation’s Eureka Discovery Utility that is provided with
the DT8837 software to locate your DT8837 instrument module quickly. Alternatively, you can
use other LXI discovery tools, such as Agilent Connection Expert, if you have them installed
on your computer. Or you can check your router’s address assignments or locate the
instrument module’s MAC (Ethernet hardware) address in your DHCP server log.

Running the Eureka Discovery Utility

To use the Eureka Discovery Utility, from the Windows Start menu, click Programs -> Data
Translation, Inc -> Instrument Support -> Eureka LXI Instrument Discovery.
A screen similar to the one shown in Figure 17 appears.

-%. Eureka (ksullivan8400.datx.com 192.43.218.62 )

P | Manufacturer | Model | Serial ersion |
192.43.218.81 Data Translation bTaa3r 3 0.0.1.1
192.43.218.44 Data Translation DT8837 5 0.0.1.1
192.43.218.39 Data Translation DT8837 5] LA e o |
192.43,218.43 Data Translation bTa337 2z 0.0.1.1
192.43.218.84 Data Translation DT8837 12 0.0.1.1
192.43.218.80 Data Translation DTea37 4 0.0.1.1

Figure 17: Eureka LXI Discovery Utility

If you are having trouble seeing your instrument module in this list, check your Windows
firewall settings using the information in the next section; otherwise, skip this section and
continue with “Launching the Web Interface” on page 54.

Configuring Windows Firewall Settings

If you are having trouble seeing your instrument module using the Eureka Discovery Utility,
check your Windows firewall settings by doing the following:

1. Right click in the tile bar of the Eureka Discovery Utility.
The following menu options appear:
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%, Eureka (ksullivan8400.datx.com 192.43.218.62 )

e ' F l Model l Serial l Version l
e tion DT8837 5 0.0.1.1
Size tion DT8837 3 0.0.1.1
= Minimize tion 018337 2 0.0.1.1
tion 0183837 6 0.0.1.1
- fion DTa837 12 0.0.1.1
tion CT8s837 4 0.0.1.1
X Close AltHFE g DT8373-498 9101026 1.6.0.2
Firewall Configuration...
About Eureka. .. {  Find LXI devices
www datatranslation.com Help

2. Click the Firewall Configuration... option.
The following window appears:
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- ;
7 Windows Firewall

General | Exceptions | Advanced |

Windows Firewall iz helping to protect your PC

Windows Firewall helps protect your computer by preventing unauthorized users
from gaining access to your computer through the Intemet or a netwiark:.

@ (%) On (recommended)

This setting blocks all outside sources from connecting to this
computer, with the exception of those selected on the Exceptions tab.

[ ] Dent allow exceptions

Select this when you connect to public networks in less secure
locations, such as aimports. You will not be notfied when Windows
Firewall blocks programs. Selections on the Bxceptions tab will be
ignored.

@ ) Off {not recommended)

Awvoid using this setting. Tuming off Windows Firewall may make this
computer more vulnerable to viruses and intruders.

Windows Firewall is using your domain settings.

What else should | know about Windows Firewall ?

ok || Cancel
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3. From the General tab, select the On (recommended) setting for proper operation of the
Eureka Discovery Utility.

4. Click the Exceptions tab, and ensure that Eureka LXI Instrument Discovery is included in
the list of exceptions:

L a w
= Windows Firewall

General | Exceptions | Advanced

Windows Firewall is blocking incoming netwanks connections, except for the
programs and services selected below. Adding exceptions allows some programs
to work better but might increase your security risk.

Programs and Services:

MName
Eureka LAl Instrument Discovery )

EVixiBrowse \
File and Printer Sharing Eureka LXI Instrument

iTunes Discovery must be
Lab%IEW 2.0 Development System listed as an exception
Lo Al

Lo Al

Lo Allowy

Lo Allowy

McAfee Framework Service

W] Mirrnenft Cfire Fyral

[

| &

| AddPogram.. | [ AddPot.. || Edt. ||  Delete

Display a notification when Windows Firewall blocks a program

What are the risks of allowing exceptions?

0K || Cancel

5. If Eureka LXI Instrument Discovery is not included in the exception list, add the utility to
the list of exceptions by doing the following:

a. Click Add Program...

b. Browse to C:\Program Files\Data Translation\Instrument Support\Eureka.exe.
The Eureka LXI Instrument Discovery utility appears in the window:
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Add a Program E'

To allow communications with a program by adding it to the Bxceptions list,
select the program. or click Browse to search for one that is not listed.

Programs:

% DT9837 Calibration Uittty

% DT9837-A Calibration Uitity

= DT9840 Series Download Utility

< DT840 Series Hash Programmer Litility
4 DT9841 Calibration Utility

% D9850 Series Calibration Utility

E Easy CD Ripper

% Eureka LI Instrument Discovery

@ Expense Report

#FAR

#j File Converter App

[

| &

Path: |C:"\F'rcg|am Files\Data TranslationInstrumert H Browse..

ok ) [Gmes

c. Click OK to add the utility to the list of exceptions.

d. Click OK to exit from the Windows Firewall Configuration menu.

Launching the Web Interface

From the Eureka utility, double-click the appropriate IP address to open the web pages for
your instrument module using your default web browser.

Alternatively, you can enter the IP address of your instrument module directly in your
Internet Explorer address bar to see the instrument module’s web interface.
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The main web page shows information about your DT8837 instrument module on the

network:

DATA TRANSLATION®

Configuration

LAN

Analog input

Device Information

device identification indicator

Analog output Manufacturer Data Translation Inc.
e Instrument model DT8837
Firmware revision 0.0.1.00
FPGA revision 1
Serial number 4
Description  Modify
Measurement & control
e LXI Class C
Acquisition =
Digital output LXI version 1.1
Help Hostname baham.datx.com

Tec

lical Support

MAC address
IP address  Modify
Link status

VISA resource string

SNTP server Modify
Current Time
Time Zone Modify

00:04:F3:01:C6:98
192.43.218.80 (DHCP)
100 Mbps,Full duplex

TCPIP::192.43.218.80::INSTR
TCPIP::192.43.218.80::5025::50CKET

192.43.244.18
FriJan 29 9:46 AM 2010
GMT -5 hour

LXI

If you have multiple DT8837 instrument modules, you can click "Turn ON front panel

identification indicator” to light the LAN LED on the instrument module, described on page
32, to indicate the device you are using.

To change the description, IP address, or time source associated with the DT8837 instrument

module, click the Modify links to navigate to the LAN Configuration page, described on page
56.
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Configuring the DT8837 Instrument Module

Web pages are provided for configuring the following aspects of your DT8837 instrument
module:

* Local Area Network (LAN) settings
* Analog input channels

* Analog output channels

e Tachometer settings

¢ Counter settings

* Clock frequency

* Trigger settings

¢ Analog input and analog output buffer mode

LAN Configuration

Use the Configuration -> LAN web page to configure the Local Area Network (LAN) settings
for the DT8837 instrument module:

DATATRANSLATION® W
S —
DT88XX
Device information LAN configuration
Configuration
Modify
Hostname
Description
@ DHCP
Automatic private IP address enabled
Static
Measurement & control Static IP Address configuration
Acquisition S . . P
Digital output SOC0ESS 2 STINTMMES Mask
Help Gateway
echnical S t :
Technical Support Primary DNS
Secondary DNS
Primary
SNTP server
Secondary
Time Zone GMT hours
Password

When you first access your DT8837 instrument module, the LAN settings that the instrument
module obtained through DHCP or AutolP should be sufficient. If you need to make changes
later, click the Modify button to enable changes.
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Note: If you want to assign a static IP address, ensure that you uncheck the checkbox called
Automatic private IP address enabled.

When you click Modify, you must supply a password for the instrument module. The
username is admin; it cannot be changed. The default password is admin. You can change the
password on this page. Note that the new password goes into effect after the device reboots. If
you are prompted for a password before the device reboots, you must enter your original
password.

Contact your system administrator and view the instrument module’s built-in help pages to
determine the correct LAN settings.

Note: If needed, you can restore the default configuration of your DT8837 instrument
module by pressing the Reset pin on the rear panel of the instrument module. For more
information, refer to “Resetting the Instrument Module” on page 33.

Analog Input Configuration

Use the Configuration -> Analog input web page to enable the analog input channels that
you want to measure, specify the gain for each channel, specify AC/DC coupling, and enable
Bias current, if desired:

DATA TRANSLATION® w I i

Analog Input Configuration

’ Save changes ” Discard changes ]

it 00| S oty S B o SN | W i e
AIN1 ] x1 10V [~ @ac ©pc Flon

AINZ ] x1 10V [~ @ac ©Opc Flon

AIN3 ] x1 10V [~ @ac ©Opc Flon

AIN4 ] x1 10V [~ @ac ©pc Flon

Measurement & control
Acquisition
Digital output

Help
Technical Support

To change your channel configuration, do the following:

1. Under Enable Channel, check the boxes next to the channels whose data you want to
acquire.
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2. Under Gain/FS, select x1 (for a gain of 1 and a full-scale range of +10 V) or x10 (for a gain
of 10 and a full-scale range of +1 V) for each analog input channel.

3. Under Coupling, select AC for AC coupling or DC for DC coupling for each analog input
channel.

4. Under Bias current, check ON to turn on the 4 mA current source for each analog input
channel. If the box is unchecked, the current source is turned off.

5. Click Save changes to apply your changes. If you do not save before leaving this page,
your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous
configuration, if desired.

Analog Output Configuration

If you want to output data from the analog output channel, select the Configuration ->
Analog output web page and check the D/A Out box.

If you want to read the value of the analog output channel in the analog input data stream
(useful for correlating input and output data), select the Configuration -> Analog output web
page and check the D/ A read back box.

The hardware aligns the value of the analog output readback channel with the analog input
measurements, so that all measurements are correlated in time. The analog output readback
channel is treated like any other channel in the analog input subsystem; therefore, all the
triggering and clocking options supported for analog input channels are supported for the
readback channel.
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Ty Analog Output Configuration
Configuration [ saechanges || Discardchanges |
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Tachometer Configuration

You can measure the frequency or period of the tachometer input signal by reading the value
of the tachometer input channel in the analog input stream. The frequency or period
measurement allows you to calculate the rotation speed of tachometer input signals.

An internal 12 MHz counter is used for the measurement, yielding a resolution of 83 ns
(1/12 MHz).

Note: You can also measure the phase of the tachometer input signal in relation to the
analog input samples using one of the counter/timer channels.

To configure the tachometer, use the Configuration -> Tachometer web page:
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1. Enable reading the tachometer input in the analog input data stream by selecting the
Configuration -> Tachometer web page and checking the Enable box.

2. Under Measurement period, select whether to measure from a rising-to-rising edge of the
tachometer signal or a falling-to-falling edge of the tachometer signal.

3. Under Stale value indicator, check the box if you want to use the most-significant bit
(MSB) of the value to indicate whether the measurement is new or old; when checked, the
MSB of the value is set to 0 to indicate new data or 1 to indicate old data. Reading the
value before the measurement is complete returns an MSB of 1 to indicate old data. If you
are not interested in whether the data is new or old, uncheck the Stale Value indicator; in
this case, the MSB is always set to 0.

4. Under the Read and clear indicator, check this box if you want to clear the value to zero
between measurements. To retain the previous measurement value until the next
measurement is complete, uncheck this box.

5. Click Save changes to apply your changes. If you do not save your changes before leaving
this web page, your changes are lost.
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You can also click the Discard changes button (before you save) to return to the previous
configuration, if desired.

The hardware aligns the value of the tachometer input with the analog input measurements,
so that all measurements are correlated in time. The tachometer input is treated like any other
channel in the analog input subsystem; therefore, all the triggering and clocking options
supported for analog input channels are supported for the tachometer input.

Counter Configuration

DT8837 instrument modules provide two 32-bit counter/timer channels for measuring the
frequency, period, or phase between two signals. Use the Configuration -> Counter web page
to configure the counters:
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1. To enable reading counter 1 and/or counter 2 in the analog input data stream, check the
Enable box for each counter that you want to read.

2. Under Measurement start edge for each counter, select one of the following signals to
start the measurement: ADC conversion complete, Tach input falling, Tach input rising,
Gate input falling, or Gate input rising.

3. Under Measurement stop edge for each counter, select one of the following signals to
stop the measurement: ADC conversion complete, Tach input falling, Tach input rising,
Gate input falling, or Gate input rising.

4. Under Read and clear for each counter, check this box if you want to clear the value to
zero between measurements. To retain the previous measurement value until the next
measurement is complete, uncheck this box.

5. Click Save changes to apply your changes. If you do not save your changes before leaving

this web page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous
configuration, if desired.
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The hardware aligns the value of the counters with the analog input measurements, so that all
measurements are correlated in time. The counters are treated like any other channel in the
analog input subsystem; therefore, all the triggering and clocking options supported for
analog input channels are supported for the counters.

Clock Frequency

Use the Configuration -> Clock web page to configure the scan frequency of the analog input
subsystem, the output frequency of the analog output subsystem, and the reference clock.

Measurement & control
Acquisition
Digital output

Help
Technical Support
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’ Save changes ” Discard changes ]

52734375 Hz

Configuring the Scan Frequency

To configure the scan frequency of the analog input subsystem, do the following:

1.
2.

Select the A/D tab of the Clock web page.

Enter a value, in Hertz, between the minimum and maximum shown in the A/D
Subsystem Clock Frequency field.

Note: The scan frequency that you specify is rounded to the closest "correct” value that
the instrument module can accept without error. When you save the A/D clock
configuration, the actual scan frequency is shown.

Click Save changes to apply your changes. If you do not save before leaving this page,
your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous
configuration, if desired.
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Configuring the Output Frequency

To configure the output frequency of the analog output subsystem, do the following:
1. Select the D/A tab of the Clock web page.

2. Enter a value, in Hertz, between the minimum and maximum shown in the D/A
Subsystem Clock Frequency field.

Note: The output frequency that you specify is rounded to the closest "correct” value that
the instrument module can accept without error. When you save the D/A clock
configuration, the actual output frequency is shown.

3. Click Save changes to apply your changes. If you do not save before leaving this page,
your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous
configuration, if desired.

Configuring the Reference Clock

To configure the reference clock used by the instrument module, do the following:
1. Select the Reference tab of the Clock web page.

2. Set the source of the reference clock for the instrument module to Internal (the default
setting) to use the internal reference clock on the instrument module, or LXI7 to use the
clock from the Trigger Bus.

3. If you want to drive out the clock on the Trigger Bus, select LXI7. If you do not want to
drive out the clock signal on the Trigger Bus, select Disabled (the default setting).

4. Click Save changes to apply your changes. If you do not save before leaving this page,
your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous
configuration, if desired.
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Trigger Configuration

Use the Configuration -> Trigger web page to configure the trigger type used by the
instrument module for starting analog input and analog output subsystems, and to drive out a
Trigger Bus LXI trigger or send a LAN trigger packet.
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You can choose one of the following trigger sources:

¢ Immediate — A software trigger event occurs when you start the analog input operation
(the computer issues a write to the instrument module to begin conversions).

e External TTL — An external digital (TTL) trigger event occurs when the instrument
module detects a rising-edge transition on the signal connected to the Trigger In input on
the instrument module. This trigger provides a threshold voltage of 2V with 0.5V of
hysteresis.

* Threshold AIN1 - An analog threshold trigger event occurs when the signal attached to
analog input channel 1 rises above a user-specified threshold value from 0.2 V to 9.8 V
with 0.1 V of hysteresis.

e Trigger Bus — When multiple DT8837 instrument modules are connected together using
the Trigger Bus, you can synchronize the start of acquisition using one of six LXI trigger
signals: LXIO to LXI5.

¢ Lan Event — When multiple DT8837 instrument modules are connected together over the
local area network (LAN), you can synchronize the start of analog input operations by
using a LAN trigger packet (0 to 7).

Configuring the Trigger Source for the Analog Input Subsystem

To configure the trigger source for the analog input subsystem, do the following:
1. Select the A/D tab of the Trigger web page.

2. Select one of the available trigger sources.
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3. Click Save changes to apply your changes. If you do not save before leaving this web
page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous
configuration, if desired.

Configuring the Trigger Source for the Analog Output Subsystem

To configure the trigger source for the analog output subsystem, do the following:
1. Select the D/A tab of the Trigger web page.
2. Select one of the available trigger sources.
3. Click Save changes to apply your changes. If you do not save before leaving this web

page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous
configuration, if desired.

Configuring the Trigger Bus LXI Trigger or LAN Trigger Packet Output

To drive out a Trigger Bus LXI trigger or send a LAN trigger packet, do the following;:
1. Select the Output tab of the Trigger web page.

2. If you want to drive out a signal on the Trigger Bus, select the LXI line that you want to
drive out: LXIO to LXI5.

3. If you want to send out a LAN trigger packet, select the LAN event (LANO to LAN7?) to
broadcast.

4. Click Save changes to apply your changes. If you do not save before leaving this web
page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous
configuration, if desired.
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Buffer Configuration

Use the Configuration -> Buffer web page to configure the buffering mode used by the
instrument module for analog input and analog output operations.

Configuring the Buffer Mode for Analog Input Operations
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To configure the buffer mode for analog input operations, do the following:
1. Select the A/D tab of the Buffer web page.
2. Select one of the following buffer modes:

— Wrap - Use this mode if you want the input operation to continue indefinitely. In this
case, when the end of the input buffer is reached, the operation wraps to the beginning
of the input buffer overwriting the oldest scan data with the latest scan data.

— Non wrap — Use this mode if you want the input operation to stop automatically when
the input buffer is filled.

3. Click Save changes to apply your changes. If you do not save before leaving this web
page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous
configuration, if desired.
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Configuring the Buffer Mode for Analog Output Operations
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To configure the buffer mode for analog output operations, do the following:
1. Select the D/A tab of the Buffer web page.
2. Select one of the following buffer modes:

— Wrap - Use this mode if you want the output operation to continue indefinitely. In this
case, when the end of the output buffer is reached, the operation wraps to the
beginning of the output buffer so that the waveform is output continuously.

— Non wrap — Use this mode if you want the output operation to stop automatically
when the end of the output buffer is reached.

3. Click Save changes to apply your changes. If you do not save before leaving this web
page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous
configuration, if desired.

4. Click Upload File to upload the file that contains the waveform values that you want to
output. Plain text file (e.g., .TXT or .CSV) should include one voltage per line, with the
number of lines representing the number of points/values that will be entered in the
buffer. Voltage values should be within 10 V range.
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Measuring Data and Controlling the Instrument

Use the Measurement & control web pages to perform the following functions:
e Start and stop acquisition on A/D and D/ A subsystems
* View data in oscilloscope
* Download measurements
* Save data to disk

¢ Control digital outputs

Starting and Stopping a Scan
Use the Measurement & control -> Acquisition web page and click the appropriate radio

button to start the A/D subsystem only, the D/A subsystem only, or both subsystems
simultaneously.
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Note: You can manually begin simultaneous subsystems using the A /D subsystem and
D/ A subsystem radio buttons. However, the D/ A subsystem must be enabled and started
before acquisition on the A /D subsystem may be triggered.
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Displaying Measurements

To display your measurement results, use the Measurement & control -> Acquisition web
page and select the Display tab.

If you start the analog input subsystem, you can see the results of your measurements in the
Oscilloscope view. Data from the counters and tachometer are shown in a digital display.
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Downloading Measurements

To download your measurement results to disk, use the Measurement & control ->
Acquisition web page and select the Download tab.
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Download measurement from AD buffer and save to file

1. Click the Start Download button on this page. Data is fetched from the beginning of the
buffer and is formatted and displayed in the text area as comma-separated values (CSV).

This process continues until either you click Stop Download or the end of the buffer is
reached.

Note: Before you click Start Download, there must be data in the A/D buffer; acquisition
must be in progress or has been started and aborted.
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2. Once download is stopped, click the Save As... button to save this CVS formatted text file
to a local directory on your computer. You can specify the name of the file and give it any
extension you want; the contents of the text area are written to the file.
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Controlling the Digital Outputs

Use the Measurement & control -> Digital output web page to view the current state of the

digital output lines, and manually change them if desired. A screen similar to the following
appears:
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Green indicates that the digital output line/relay is closed; red indicates that the digital output
line/relay is open.

To change the status of a digital output line/relay, click the Open/Close toggle buttons under
the Control heading for the digital output lines that you want to change.
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Figure 18 shows a block diagram of the DT8837 instrument module.

Figure 18: Block Diagram of the DT8837 Instrument Module

76



Principles of Operation

Analog Input Features

This section describes the following features of analog input (A /D) subsystem on the DT8837
instrument module:

¢ Analog input channels, described below

* Input ranges and gains, described on page 77
e IEPE functions, described on page 78

¢ Input resolution, described on page 78

e Input clock source, described on page 78

* Input buffer, described on page 79

* Input triggers, described on page 80

Analog Input Channels

The DT8837 instrument module supports four, differential analog input channels (numbered 1
to 4). Using software, you enable the channels that you want to sample. All analog input
channels are simultaneously clocked. If desired, you can connect IEPE sensors to these inputs;
refer to page 78 for more information on IEPE functions.

Note: To maintain simultaneous operation, all analog input connections must have the same
lead lengths.

The DT8837 instrument module uses Delta-Sigma analog-to-digital converters (ADCs) that
provide anti-aliasing filters based on the clock rate. These filters remove aliasing, which is a
condition where high frequency input components erroneously appear as lower frequencies
after sampling.

In addition to the analog input channels, the DT8837 instrument module can acquire data
from a tachometer, two counter/timers, and the analog output readback channel, depending
on whether these channels are enabled for sampling. Refer to”Input Buffer” on page 79 for
more information on reading data from these channels. For information on the tachometer,
refer to page 85. For information on the counter/timers, refer to page 87. For information on
the analog output readback channel, refer to page 83.

Input Ranges and Gains
The DT8837 instrument module provides an input range of £10 V and software-selectable

gains of 1 and 10. This provides effective input ranges of +10 V (when the gainis 1) and 1 V
(when the gain is 10).
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IEPE Functions

Applications that require accelerometer, vibration, noise, or sonar measurements often use IEPE
sensors. IEPE conditioning is built-in to the analog input circuitry of the DT8837 instrument
module. The instrument module supports the following software-programmable IEPE
functions for each of the four analog inputs:

¢ Excitation current source — You can enable or disable the use of a 4 mA internal excitation
current source with 24 V compliance voltage to allow wide dynamic range without
distortion. By default, the excitation current source is disabled.

¢ Coupling type — You can select whether AC coupling or DC coupling is used. By default,
AC coupling is selected.

Note: If you enable the use of the internal 4 mA excitation current source, it is recommended
that you choose AC coupling. Refer to page 38 for more information on wiring IEPE inputs.

Input Resolution

The resolution of the analog input channels is fixed at 24 bits; you cannot specify the
resolution in software.

Input Clock Source

The DT8837 instrument module supports an internal master clock and an internal sync signal
that synchronizes all the analog-to-digital converters on the instrument module.

Use software to specify the internal clock source, the internal A/D sync signal, and the
frequency at which to pace the input and output operations and to start the sample clock. The
sampling frequency ranges from 195.3 Hz to 52.734 kHz.

Note: According to sampling theory (Nyquist Theorem), specify a frequency that is at least
twice as fast as the input’s highest frequency component. For example, to accurately sample a
20 kHz signal, specify a sampling frequency of at least 40 kHz to avoid aliasing.

The DT8837 instrument module supports a wide pass band of 0.1 Hz to 25.8 kHz (0.49 x
sampling frequency) to eliminate aliasing, allowing you to measure low frequency signals
accurately at the Nyquist sampling rate.

The actual frequency that the instrument module can achieve may be slightly different than
the frequency you specified due to the accuracy of the clock. You can determine the actual
clock frequency using software.
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The value that you specify for the internal clock frequency is multiplied by 512 internally to
set the oscillator on the instrument module. For example, if you specify an internal clock
frequency of 50 kHz, the instrument module sets the internal oscillator for the A/D converters
to 25.6 MHz. The maximum timebase is 27 MHz.

Once the sample clock is started, the instrument module requires 39 clock pulses before the
first A/D conversion is completed (39/sample rate) due to the group delay of the converters.
The hardware adjusts for the group delay to provide only valid data. The first sample
returned is the sample corresponding to the analog input signal at the time of the trigger.

Note: The tachometer, counter/timer, and analog output readback data (which does not
have the 39 sample group delay) is fed through a hardware queue to realign it with the
adjusted analog input data stream.

If you are synchronizing analog input operations on multiple DT8837 instrument modules
using the Trigger Bus, refer to “Synchronizing Operations on Multiple Instrument Modules”
on page 90.

Input Buffer

DT8837 instrument modules use an 8 MB input buffer for storing data from each of up to 8
enabled input channels (analog input channels 1, 2, 3, 4, tachometer input channel (5),
counter/timer 1 (6), counter/timer 2 (7), and the analog output readback channel (8)). One
sample from each of the enabled input channels is called a scan.

You can specify one of the following wrap modes for the input buffer in software:

¢ Continuous wrap mode — Use this mode if you want the input operation to continue
indefinitely. In this case, when the end of the input buffer is reached, the operation wraps
to the beginning of the input buffer overwriting the oldest scan data with the latest scan
data.

* No wrap mode — Use this mode if you want the input operation to stop automatically
when the input buffer is filled.

Note: Since the maximum input buffer size is 8 MB and each sample is 4 bytes, you can store
a maximum of 2 M samples in the input buffer. If you sample each input channel at the
maximum input frequency (52.734 kHz), the input buffer will fill in approximately 5 seconds
(52 ksamples/s per channel).

The maximum size of data transfer over Ethernet is 32 kB. Since each sample is 4 bytes, the
maximum number of samples is 8 ksamples. Therefore, if you are using continuous wrap
mode, ensure that you use a tight loop to ensure that you retrieve all the samples in the input
buffer before the buffer is overwritten.
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Figure 19 illustrates continuous wrap mode using a channel list with five entries: analog input
channel 1, 2, 3, 4, and the tachometer (5). In this example, data is acquired simultaneously on
all channels on each clock pulse of the input sample clock. Data is acquired continuously until
all the queued buffers have been filled or you stop the operation.

Chan 5 Chan 5 Chan 5 Chan 5
Chan 4 Chan 4 Chan 4 Chan 4
Chan 3 Chan 3 Chan 3 Chan 3
Chan 2 Chan 2 Chan 2 Chan 2
Chaln 1 Crllan 1 Chqn 1 Chlan 1
I
Input |
Sample |
Clock

Data is acquired continuously

Initial trigger event occurs

Figure 19: Continuous Wrap Mode

Input Triggers

A trigger is an event that occurs based on a specified set of conditions. Once the analog input
subsystem is armed using software (and if the trigger source is immediate, and started using
software), acquisition starts when the instrument module detects the initial trigger event and
stops when either the input buffer has been filled (if no wrap mode was selected), or you stop
the operation (if continuous mode is selected).

Note: The Input Trigger LED on the front panel of the DT8837 instrument module turns
solid amber when the analog input subsystem is armed and solid green when the analog
input subsystem is triggered. When the analog input subsystem is idle, the Input Trigger LED
is off.

The DT8837 instrument module supports the following trigger sources for starting analog
input operations:

¢ Immediate software trigger — A software trigger event occurs when you start the analog
input operation (the computer issues a write to the instrument module to begin
conversions). Using software, specify the trigger source as an immediate trigger and
initiate the operation.

¢ External digital (TTL) trigger — An external digital (TTL) trigger event occurs when the
instrument module detects a rising-edge transition on the signal connected to the Trigger
In input on the instrument module. This trigger provides a threshold voltage of 2 V with
0.5 V of hysteresis. Using software, specify the trigger source as an external.
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* Analog threshold trigger — An analog threshold trigger event occurs when the signal
attached to analog input channel 1 rises above a user-specified threshold value from 0.2 V
t0 9.8 V with 0.1 V of hysteresis. Using software, specify the trigger source as a threshold
trigger.

e Trigger Bus — When multiple DT8837 instrument modules are connected together using
the Trigger Bus, you can synchronize the start of acquisition using one of six LXI trigger
signals: LXIO to LXI5. Refer to”“Synchronizing Operations on Multiple Instrument
Modules” on page 90 for more information.

* LAN Trigger Packet — When multiple DT8837 instrument modules are connected together
over the local area network (LAN), you can synchronize the start of analog input
operations by using LAN trigger packets. Refer to page 93 for more information.
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Analog Output Features

This section describes the following features of analog output operations:
¢ Analog output channels, described below
¢ Output ranges and gains, described below
¢ Output resolution, described on page 82
* Output clock, described on page 82
¢ Qutput buffer, described on page 83
* Analog output readback channel, described on page 83
* Output triggers, described on page 83

Analog Output Channels
The DT8837 instrument module supports one 24-bit analog output channel. To update the
analog output channel, you must enable the channel in software. You can also read back the
value of the analog output channel through the analog input data stream; refer to page 83 for

more information.

A two-pole, 10 kHz Butterworth filter is applied to prevent noise from interfering with the
output signal. The analog output channel powers up to a value of 0 V.

Output Ranges and Gains

The DT8837 instrument module can output bipolar analog output signals in the range of
+10 V, with a gain of 1.

Output Resolution

The resolution of the analog output channel is fixed at 24-bits; you cannot specify the
resolution in software.

Output Clock

The output clock on the DT8837 instrument module is derived from an internal master clock.

You can program the output frequency to value between 10 kHz and 52.734 kHz. Use software
to specify an internal clock source and to specify the clock frequency for the analog output
subsystem.

Due to the group delay of the Delta-Sigma D/ A converter, the DT8837 requires 29 sample
clock pulses once the analog output has been triggered before the analog output reflects the

first value in the output buffer.

If you are synchronizing multiple DT8837 instrument modules using the Trigger Bus, refer to
“Synchronizing Operations on Multiple Instrument Modules” on page 90.
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Output Buffer

DT8837 LXI instrument modules use an 128K sample output buffer (also known as a
hardware FIFO) for storing analog output data to write to the analog output channel.

You can specify the number of samples to output to the analog output channel using software.
This value can range between 1 and 131072.

Using software, load the output buffer with the values that you want to write to the analog
output channel. Each value in the buffer corresponds to a sample that you want to output to
the analog output channel. Values are written to the analog output channel starting with the
first sample in the buffer.

You can specify one of the following wrap modes for the output buffer in software:

¢ Continuous wrap mode — Use this mode if you want the output operation to continue
indefinitely. In this case, when the end of the output buffer is reached, the operation wraps
to the beginning of the output buffer and continues updating the analog output channel
with the values stored in the buffer.

¢ No wrap mode — Use this mode if you want the output operation to stop automatically
when the number of samples specified has been output.

Reading the Analog Output Value in the Analog Input Data Stream

If desired, you can read back the value of the analog output channel in the analog input data
stream by enabling the DAC readback channel (8) in software.

When the analog input operation is started, the value of the analog output channel is returned
in the analog input data stream. (An analog value is returned.) The hardware aligns the value
of the analog output channel with the analog input measurements, so that all measurements
are correlated in time.

Output Triggers

A trigger is an event that occurs based on a specified set of conditions. Once the analog output
subsystem is armed using software (and if the trigger source is immediate, and started using
software), the analog output operation starts after the trigger is received and stops when
either the specified number of samples have been output (if no wrap mode is selected) or you
stop the operation (if continuous wrap mode is selected).

Note: The Output Trigger LED on the front panel of the DT8837 instrument module turns
solid amber when the analog output subsystem is armed and solid green when the analog
output subsystem is triggered. When the analog output subsystem is idle, the Output Trigger
LED is off.
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The DT8837 instrument module supports the following trigger sources for starting analog
output operations:

¢ Immediate software trigger — A software trigger event occurs when you start the analog
output operation (the computer issues a write to the instrument module to begin
conversions). Using software, specify the trigger source for the D/ A subsystem as a
software trigger and initiate the operation.

¢ External digital (TTL) trigger — An external digital (TTL) trigger event occurs when the
instrument module detects a rising-edge transition on the signal connected to the Trigger
In input on the instrument module. This trigger provides a threshold voltage of 2 V with
0.5 V of hysteresis. Using software, specify the trigger source for the D/A subsystem as an
external.

* Analog threshold trigger — An analog threshold trigger event occurs when the signal
attached to analog input channel 1 rises above a user-specified threshold value from 0.2 V
t0 9.8 V with 0.1 V of hysteresis. Using software, specify the trigger source for the D/A
subsystem as a threshold trigger.

e Trigger Bus — When multiple DT8837 instrument modules are connected together using
the Trigger Bus, you can synchronize the start of analog output operations using one of six
LXI trigger signals: LXI0 to LXI5. Refer to”Synchronizing Operations on Multiple
Instrument Modules” on page 90 for more information.

* LAN Trigger Packet — When multiple DT8837 instrument modules are connected together
over the local area network (LAN), you can synchronize the start of analog output
operations by using LAN trigger packets. Refer to page 93 for more information.
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Tachometer Input Features

DT8837 instrument modules accept one tachometer input signal on the J6 input/output
connector. You can measure the frequency or period of the tachometer input signal by reading
the value of the tachometer input channel in the analog input stream. The frequency or period
measurement allows you to calculate the rotation speed of tachometer input signals. An
internal 12 MHz counter is used for the measurement, yielding a resolution of 83 ns (1/12
MHz).

Note: You can also measure the phase of the tachometer input signal in relation to the
analog input samples using one of the counter/timer channels, described on page 87.

To read the number of counts between two edges of the tachometer input signal, enable the
tachometer input (channel 5) in the analog input data stream.

Using software, you can specify the following parameters for tachometer frequency and/or
period measurement:

¢ Period type — Specifies which period of the tachometer input signal to measure
(rising-to-rising edge or falling-to-falling edge).

¢ Self Clear flag — Indicates whether the value read between measurements is cleared or
retained. To clear the value to zero between measurements, set this flag to 1. To retain the
previous measurement value until the next measurement is complete, set this value to 0.

e Stale Value flag — Determines whether to use the most significant bit (MSB) of the returned
32-bit value to indicate new or old data. The count is the bottom 31 bits and the stale flag
is the 32nd bit or MSB. To use the MSB of the value to indicate whether the measurement
is new or old, set the Stale Value flag to active (1). When this flag is active, the MSB of the
value is set to 0 to indicate new data or 1 to indicate old data. Reading the value before the
measurement is complete returns an MSB of 1 to indicate old data.

If you are not interested in whether the data is new or old, set the Stale Value flag to 0. In
this case, the MSB is always set to 0.

When the tachometer is enabled, the internal 12 MHz counter starts incrementing when it
detects the first specified edge of the tachometer input. When the specified edge is detected,
the count is stored in a holding register and the counter resets and starts counting again. The
tachometer holding register is read at the input sample rate and included as part of the input
scan data. Tachometer counting is independent of the input sample rate. On the next read,
either 0 or the current value of the tachometer input (from the previous measurement
operation) is returned depending on the value of the Self Clear flag, described above, and the
next operation is started automatically.

The hardware aligns the value of the tachometer input with the analog input measurements,
so that all measurements are correlated in time. The tachometer input is treated like any other
channel in the analog input subsystem; therefore, all the triggering and clocking options
supported for analog input channels are supported for the tachometer input.
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When you read the value of the tachometer input as part of the analog input data stream, you
might see results similar to the following (note that this assumes that the previous
measurement value is returned between new measurement values):

Table 2: An Example of Reading the Tachometer Input as Part of the Analog Input Data Stream

Tachometer
Time A/D Value Input Value Status of Operation
10 5002 0 Operation started, but is not complete
20 5004 0 Operation not complete
30 5003 0 Operation not complete
40 5002 12373 Operation complete
50 5000 12373 Next operation started, but is not complete
60 5002 12373 Operation not complete
70 5004 12373 Operation not complete
80 5003 14503 Operation complete
90 5002 14503 Next operation started, but is not complete

Using the count that is returned from the tachometer input, you can determine the following:

¢ Frequency of a signal pulse (the number of periods per second). You can calculate the
frequency as follows:

— Frequency = 12 MHz/(Number of counts — 1)
where 12 MHz is the internal counter/timer clock frequency
For example, if the count is 21, the measured frequency is 600 kHz (12 MHz/20).
e Period of a signal pulse. You can calculate the period as follows:
— Period = 1/Frequency

— Period = (Number of counts — 1)/12 MHz
where 12 MHz is the internal counter/timer clock frequency
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Counter/Timer Channels

DT8837 instrument modules provide two 32-bit counter/timer channels for measuring the
frequency, period, or phase between any of the following signals:

¢ Completion of the A/D sample to the rising or falling edge of the tachometer input signal
(on the J6 connector)

e Completion of the A/D sample to the rising or falling edge of the gate input signal (on the
J6 connector)

¢ Rising or falling edge of the gate input signal to the rising or falling edge of the
tachometer input signal

* Rising or falling edge of the gate input signal to the rising or falling edge of the gate input
signal, which you can use to determine the pulse width or period of the gate signal

¢ Rising or falling edge of the tachometer input signal to the rising or falling edge of the
tachometer input signal, which you can use to determine the pulse width or period of the
tachometer signal

¢ Rising or falling edge of the tachometer input signal to the completion of the A/D sample

¢ Rising or falling edge of the gate input signal to the completion of the A/D sample

Using the count that is returned from the counter/timer, you can determine the following;:

e Frequency of a signal pulse (the number of periods per second). You can calculate the
frequency as follows:

— Frequency = 48 MHz/(Number of counts — 1)
where 48MHz is the internal counter/timer clock frequency

For example, if the count is 81, the measured frequency is 600 kHz (48 MHz/20).
e Period of a signal pulse. You can calculate the period as follows:
— Period = 1/Frequency

— Period = (Number of counts — 1) /48 MHz
where 48 MHz is the internal counter/timer clock frequency

To read the value of the counter in the analog input data stream, enable the counter/timer in
software. Counter/timer 1 is returned as channel 6 in the analog input stream; counter/timer
2 is returned as channel 7 in the analog input stream

When a counter is enabled, the internal 48 MHz counter starts incrementing when it detects
the first specified start edge. When the specified stop edge is detected, the count is stored in a
holding register and the counter resets and waits for the next start edge. The counter holding
register is read at the input sample rate and included as part of the input scan data. The
counter/timer counting is independent of the input sample rate so depending on the input
sample rate and the counter input rate, you could either always read a new count value or
depending on the value of the Self Clear flag, described below, read several old count values
or 0. Since these counters have a selectable start and stop edge, if the same edge is selected as
the start and stop edge, the counter will count every other signal period, not every period like
the tachometer counter.
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Using software, you can specify the following parameters for the measurement:

¢ The signal that starts the measurement: ADC conversion complete, rising edge of the
tachometer input signal, falling edge of the tachometer input signal, rising edge or the
gate input signal, or falling edge of the gate input signal

e The signal that stops the measurement: ADC conversion complete, rising edge of the
tachometer input signal, falling edge of the tachometer input signal, rising edge or the
gate input signal, or falling edge of the gate input signal

Note: Note that if you choose to start the measurement using the A/D sample, choose a
different signal to stop the measurement. Likewise, if you choose to stop the measurement
using the A /D sample, choose a different signal to start the measurement.

e Self Clear flag — Indicates whether the value read between measurements is cleared or
retained. To clear the value to zero between measurements, set this flag to 1. To retain the
previous measurement value until the next measurement is complete, set this value to 0.

88



Principles of Operation

Digital Output Features

DT8837 instrument modules feature four, isolated digital output lines. The digital outputs are
solid-state relays that operate at +30 V and 400 mA peak (AC or DC). Switching time is 2 ms
maximum. Digital outputs resemble a switch; the switch is closed if the state of the digital
output line is 1, and the switch is open if the state of the digital output line is 0. On power up
or reset, the digital outputs are disabled.

Using software, you can close or open a digital relay.
You can also change the value of specific digital output lines without affecting all of the digital

output lines by performing the following bitwise operations:

¢ Using software, you can compare the binary representations of a specified value between
0 and 15 and the current value of the digital output port, and perform a logical AND
operation on each pair of corresponding bits. If both bits are 1, the result is 1. If both bits
are 0, the result is 0. If one bit is 1 and the other bit 0, the result is 0.

The following example shows the result of a logical OR operation:

Table 3:

0101
AND 0011
= 0001

* OR - Using software, you can compare the binary representations of a specified value
between 0 and 15 and the current value of the digital output port, and perform a logical
OR operation on each pair of corresponding bits. If both bits are 1, the result is 1. If both
bits are 0, the result is 0. If one bit is 1 and the other bit 0, the result is 1.

The following example shows the result of a logical AND operation:

Table 4:

0101
OR 0011
0111

You can query the current configuration of the digital output port in software.
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Synchronizing Operations on Multiple Instrument
Modules

You can synchronize the start of acquisition on multiple instrument modules using LXI
triggers on the Trigger Bus or LAN trigger packets. If you want the clock to be synchronous,
you need to use the Trigger Bus.

Using the Trigger Bus

Up to 16 LXI devices can be connected together using the Trigger Bus. DT8837 instrument
modules may be connected using a daisy-chain configuration, as shown in Figure 20, using
the 25-pin J7 Trigger Bus connectors. Both the first device and the last device in the chain must
have Trigger Bus terminators installed. Terminators must also be installed on both ]J7
connectors if you are using only one instrument module.

Daisy-Chain Configuration

Trigger Bus Terminators

Figure 20: DT8837 Instrument Modules in Daisy-Chain Configuration

When multiple DT8837 instrument modules are connected together using the Trigger Bus, as
shown in Figure 21, you can synchronize the start of acquisition using one of six LXI trigger
signals: LXIO to LXI5. One DT8837 is the clock master, responsible for driving out the clock
signal (LXI7) and sync signal (LXI6) for use by the other slave instrument modules. The slave
instrument modules must be configured to accept these signals.

Internally, the trigger signals from the Trigger Bus are wired to the analog input subsystem.
Therefore, choosing an LXI trigger for analog output operations is appropriate only if you
want to trigger both the analog input and analog output subsystem of multiple instrument
modules at the same time.
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Note: The order in which you set up the clock and triggers is important; refer to your
software documentation for more information. While the clock frequencies can be different
on each instrument module, we recommend that you chooses the same clock frequency for all
instrument modules. However, the analog input and output clock frequencies can be
different from each other.

DT8837 DT8837 DT8837
Master Slave 1 Slave n
Trigger Source = | | TriggerSource= | g, | Trigger Source =
Immediate, LXIOto LXI5- | LXIO,LXI1,LXI2, | LXI0toLXI5 | LXIO, LXI1, LXI2,
Digital, Trigger LXI3, LXI4, or LXI5 LXI3, LXI4, or LXI5
Threshold,
LAN Tri Packet Enabled and
rigger Packe Driven
Clock Source = -l Clock Source > Clock Source
- LXI6 - Sync
Internal LXI6 - Syne = LXI7 y = LXI7
P
LXI7 - Clock LXI7 - Clock

Figure 21: Synchronizing the Start of Acquisition When Connecting Multiple Instrument Modules
to the Trigger Bus

Note: When using LXI triggers, the timing from device to device is guaranteed to be within
one sample pulse.

Unlike when synchronizing the clock of multiple instrument modules, which requires one
instrument module dedicated as the clock master, you can have more than one trigger master,
if desired, to trigger multiple instrument modules. Additionally, the trigger master need not
be the clock master. Figure 22 shows an example of using two trigger masters on the Trigger
Bus.
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DT8837 DT8837 DT8837 DT8837
Trigger Master 1 Slave 1 Trigger Master 2 Slave 2
Trigger Source || y.0 ™| Trigger Source m’ Trigger Source [ — | Trigger Source
= Digital Trigger = LXI0 = Threshold = LXI5
Enabled >
and LXI5 -
Driven Trigger
Enabled
and
Driven
External Slave 1 is triggered Analog Slave 2 is triggered
Digital by Trigger Master 1. Threshold by Trigger Master 2.
Trigger Trigger

Figure 22: An Example of Using Two Trigger Masters on the Trigger Bus

On the trigger master, use software to set the trigger source to software trigger, external digital
trigger, analog threshold trigger, or LAN trigger packet (LANO to LAN7). Then, use software

to drive out the LXI trigger signal (LXIO to LXI5) on the Trigger Bus.

Note: While a trigger master can drive out more than one trigger signal on the Trigger Bus,

the slave can accept only one trigger signal to start the analog input operation.

On each slave, use software to select the trigger signal (LXIO to LXI5) that was driven out by

the trigger master on the Trigger Bus and arm the analog input subsystem.

Once the master is armed and triggered, the specified LXI trigger signal is driven out on the
Trigger Bus to all slaves that were configured to accept it. Acquisition starts on the first sample

after the trigger is received.
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Using LAN Trigger Packets

When multiple DT8837 instrument modules are connected together over the local area
network (LAN), as shown in Figure 23, you can synchronize the start of analog input and
output operations by transmitting one of eight LAN trigger packets (LANO to LANY) over the

network.
Computer
I LAN
DT8837 DT8837 DT8837 DT8837
1 2 3 n

Figure 23: Synchronizing the Start of Analog I/0 Operations When Triggering Instruments Modules
Over the LAN

The timing of the trigger packets from device to device is dependent on the network traffic on
the LAN.

The DT8837 supports multicast transmission of LAN trigger packets using UDP (User
Datagram Protocol) port 5044 and UDP multicast address 224.0.23.159. The DT8837 does not

support unicast LAN events transmitted via TCP connections.

Figure 24 shows the format of a LAN trigger packet:

HW i Time E h FI Dat
Detect Domain | EventID |Sequence stamp poc ags ata 0

(3 bytes) | (1byte) (16 bytes) | (UInt32) | (1g pytes)| (UINt16) | (UInt16) |  Fields | (2 Bytes)

Figure 24: Format of a LAN Trigger Packet

The fields of the LAN trigger packet are described as follows:

¢ HW Detect — Identifies valid packets and is reserved for future hardware detection of
LAN events. This field should be set to LXI. Note that the third byte, ASCII "I", is also used
as a version identifier; future revisions to the LXI standard may change this value.
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Domain — This field represents a group of devices that are managed by a single directory
and use shared resources. Values for the LXI domain range from 0 to 255. The default
value is 0. This field is treated as an unsigned byte.

To transmit LAN trigger packets to or from a DT8837 instrument module, ensure that you
set the domain field of each DT8837 instrument module to the same value using software.

Event ID — This field contains the first 16 bytes of the event name (a string). By default, the
LAN event names are defined as LANO to LAN7.

To transmit LAN trigger packets to or from a DT8837 instrument module, ensure that you
set the event ID of each DT8837 instrument module to the same value using software.

Sequence — Each instrument module maintains its own sequence; the sequence number is
incremented every time a unique packet is transmitted. (Note that if packets are
retransmitted to enhance reliability, re-transmitted packets contain the same sequence
number as the original.)

Time stamp — For DT8837 instrument modules, the time stamp of received LAN event
packets is ignored, while generated LAN event packets have a time stamp of 0.

Epoch — For DT8837 instrument modules, this value is 0.

Flags — Contains data about the packet. This value is generated automatically by DT8837
instrument modules.

Data Fields — Arbitrary number of bytes, up to the capacity of the data packet. This field is
generated automatically by DT8837 instrument modules.

To trigger analog input or analog output operations on a DT8837 instrument module using a
LAN trigger packet, set up the domain and the event ID of the LAN trigger packet, as
described on page 93, and then do the following:

1.

4.

Use software to set the trigger source for the analog input or analog output subsystem of
each DT8837 instrument module to the enabled LAN trigger packet (LANO to LAN7).

Enable the LAN event (LANO to LAN?) for transmission using software.

Specify the destination or source address for the enabled LAN event (LANO to LAN?7)
using software.

Arm the analog input or analog output subsystem.

Acquisition starts with the first sample after the specified LAN trigger packet is received.
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Overview

The VIBpoint Framework application allows you to acquire and analyze data from up to 16
synchronized DT8837 Ethernet/LXI instrument modules. A 14-day trial version of this
application is provided with the instrument module. After the trial period has elapsed, you
must purchase a license to continue using this application.

Note: The VIBpoint Framework application also supports the DT9837 Series USB modules.

The VIBpoint Framework application lets you perform the following functions:

Discover and select your instrument modules.

Configure all input channel settings, such as the enable state, AC/DC coupling, input
ranges, and edges for the tachometer and counters, as well as the clock and trigger
settings.

Load/save multiple hardware configurations.

On each instrument module, acquire data from all channels specified in the input channel
list.

Display acquired data during acquisition.

Perform FFIs (Fast Fourier Transforms) on the acquired analog input data. You can select
the FFT size and window type, and choose one of the following FFT averaging modes, if
desired: Linear, Exponential, and Peak Hold.

Use the Chart Recorder to display a snapshot of data, plot the FFT results from the
selected analog input channels, and log the data to disk in a tab-separated file.

Open recorded data in Excel for further analysis.

Use the Channel Overview window to view the data from your device as a digital display.

You can customize many aspects of the acquisition, display, and recording functions to suit

your needs, including which channels are recorded are displayed in the Chart Recorder and
Channel Overview windows, which units to use for the data (such as voltage, frequency, or
time), the frequency of your input analog input signals, and the trigger type used.
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Running the VIBpoint Framework Application

To run the VIBpoint Framework application, perform the following steps:

1. Click Start -> Programs -> Data Translation, Inc -> VIBpoint Framework -> VIBpoint
Framework Application
The Device Selection screen is displayed:

DECEEEEES WAL

Device Family

(DTe837 -
Available Devices Selected Devices
(19243218125 ~v| [ Refresh | ' Senal
MName IP Address M Master

Model: DT8837

Serial Mumber: 14

Firmware Version: 1.0.0.0

Driver Version: 1.0.2.0 << Remove
@ Deviceisidle.

[ ok | [ cancel |

Available Device info queried successfully.

2. Select DT8837 from the Device Family list.

Note: The DT8837 IVI-COM device driver must be installed to see the DT8837 in the
Device Family list.

3. By default, the application "discovers" all devices that are available for the selected Device
Family and, for the DT8837, displays their IP addresses in the drop-down list. If you want
to refresh this list to determine if other devices are available, click Refresh.

4. If your instrument module is included in the list of available devices and you want to
connect to it, select the IP address for the instrument module that you want to use from
the list of available devices, and click Add.

Information about the device, including the model number, serial number, firmware version, driver
version, and scanning status is displayed.
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Device Family
[DT8837

Avazilable Devices

[19243218.125

Model: DT8837

Seral Number: 14
Firmware Version: 1.0.0.0
Driver Version: 1.0.2.0

. Device iz idle.

[ ok ] [ Concel |

IP Address

Serial
Mumber

192.43.218.125 |14

Available Device info queried successfully.

5. If your instrument is not included in the list of available devices, but you want to
manually connect to it, do the following:

a. Click Advanced.

b. Enter the IP address of the instrument module you want to connect to, and click OK.

c¢. From the Device Selection window, click Add.

6. (Recommended) If you want to rename your DT8837 instrument module, do the

following:

Enter the IP Adress of the
device you would like to add
to the available list:

a. Click the Row Selector button for the device.

b. Click the IP address in the Name column to highlight it and enter a meaningful name

to represent each available device.
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Serial
Name IP Address M Master
Master 19243218125 (14
7 Slave 192.43.218.126 | 201005600
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7. If you are using multiple instrument modules, you must set up one instrument module as
the clock and trigger master as follows:

a. Click the Row Selector button for the instrument module that you want to be the
clock and trigger master.

b. For the clock and trigger master device, check the box under the Master column.

Serial
Mame IP Address TR Master
7 || master 192.43.218.125 | 14
Slave 192.43.218.126 | 201005600 Bl

Note: Only one device can be the clock and trigger master. If you are using a single
device, the application automatically configures the device as the master.

You can synchronize up to 16 DT8837 devices in a master/slave configuration. The master
drives out the trigger signal on LXI Trigger Bus line 0 unless the master was set up to be
triggered on that line, in which case it drives out the trigger signal on Trigger Bus line 1.
The slaves are configured to accept the clock and trigger from the Trigger Bus
automatically.

8. (Optional) If you want to remove a device from the selected DT8837 instrument modules,
click the Row Selector button for the device, and then click Remove.

9. Once you have added all the devices you want to use with the application, click OK.
The latest state is saved and used when the application is next run, and the main window of the
VIBpoint Framework application is displayed.
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Changing the Configuration of Your Instrument Module

You must choose Stop from the Acquisition menu or click the stop button on the main
window before you can make changes to your instrument module configuration.

To change the configuration of your instrument module, follow these steps:

1. Click the Configuration menu, and then click Change Configuration.

The Change Configuration screen is displayed:

[ ot Configure De\.ﬂces“u . -,s @Mﬂ
Channel Enable Channel Name Range Coupling g;rurfcrg
aster v AD +- 10V * |AC hd
Master-2 [ AD2 /- 10V ~ |AC - [
Master-3 [ AD3 /- 10V * |AC - ]
Master-4 [ AD 4 /- 10V ~ |AC - [
Slave-1 E ADA /- 10V * |AC - E
Slave-2 [ AD2 /- 10V ~ |AC - E
Slave-3 [ AD3 /- 10V ~ |AC - [
Slave-4 [ AD 4 /- 10V ~ |AC - [
Channel  Enable Channel Name Tach Edge
Master-5 Tach.1 Falling
Slave-5 Tach.1 Falling
Channel  Enable Channel Name Start Edge Stop Edge
Master-f Ctr.1 A/D Complete » | A/D Complete
Master-7 E Ctr.2 A/D Complate - | A/D Complete
Slave-6 Ctr1 A/D Complete w || A/D Complete
.Slave-? Cir2 A/D Complete w || A/D Complete
||
|

. Select the channels that you want to enable for acquisition by clicking the Enable

checkbox for those channels. Only data from enabled channels is included in the analog
input data stream.

. Under Channel Name, specify a meaningful name to represent each channel, if desired.

. For analog input channels, configure the input signal range for each channel as +10 V or

+1 V.

. For analog input channels, configure the following IEPE settings:

— 4mA current source — Enable use of the 4 mA current source by checking the Current
Source checkbox, or disable use of the 4 mA current source by unchecking the Current
Source checkbox.

— Coupling type — Select AC for AC coupling or DC for DC coupling.
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10.

11.

For tachometer 1, select which period of the tachometer input signal to measure:
— Rising — Measures from the rising-to-rising edge of the tachometer input signal.
— Falling — Measures from the falling-to-falling edge of the tachometer input signal.

For counters 1 and 2, select the signal edge that will start and stop the measurement. You
can choose from the following signals: Gate Rising, Gate Falling, Tach Falling, Tach
Rising, or A/D Complete.

When you are finished configuring the VIBpoint Framework application, click Close.
The latest state is saved and used when the application is next run.

To save the configuration settings to a file, click the Configuration menu, and then click
Save Configuration.

Enter a name for the configuration file, select the directory in which to save the file, and
then click Save.
This file has the extension (*.xml).

Note: If you are using a US version of Windows Vista or Windows 7, the default
configuration file (with the extension *.xml) is saved to the following location:
C:\Program Data\Data Translation\ VIBpoint Framework\Config.

If you are using a US version of Windows XP, the default configuration file is saved to this
location: C:\Documents and Settings\ All Users\ Application Data\Data
Translation\ VIBpoint Framework\Config.

You can save numerous configuration settings, if desired. To load a previously saved
configuration, click the Configuration menu, and then click Load Configuration.

Start acquisition by clicking Start from the Acquisition menu or by clicking the Start
() button from the main window.
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Acquire, Display, and Record Data

Before you start acquisition, set up the Recording and Trigger settings. You can use the Chart
Recorder and Channel Overview windows to view the acquired data. This section describes

how to acquire, display, and record data to disk.

Recording Settings

Recording | Trigger

Maximum frequency
lo analyze

500

Recording Time (Sec)

512
{Actual recording time will
be adjusted based on
Frequency and FFT Size
settings)
FET
FFT Size
1024 -
Window Type

MNone -

Spectral Averaging

Averaging Type
None hd

Weighting factor
09

Acquisition info

Sample rate: 1000 Hz
Sample interval: .001 Sec
Number of scans: 5120
Number of FFTs: 5

To specify how data is acquired by the DT8837 instrument module, configure the following
Recording settings:

* Maximum frequency to analyze — Specify the bandwidth or span of the input signals that
you want to analyze. Internally, the software multiplies this value by 2 to set the sampling
rate of the instrument module. This information is shown in the Acquisition info section

of the Recording tab.

* Recording Time (Sec) — Specify the amount of time, in seconds, that you want the
application to acquire data before stopping. This value must be a multiple of the FFT size.
The software automatically adjusts this value based on the values you enter for Maximum

frequency to analyze and the FFT size.
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* FFT Size — Specify how many data points are used to generate the FFIs for the analog
input channels.

¢ Window Type — Specify the type of windowing function to use for the FFT: Hamming,
Hanning, Bartlett, Blackman, or None.

* Averaging Type — If you want to average FFTs rather than showing an FFT for each scan,
choose one of the following spectral averaging modes; otherwise, choose None:

— Linear — With linear averaging, data from each FFT is averaged with the data from the
other FFTs; all data contributes equally to the average.

— Exponential — With exponential averaging, new FFT data is weighted differently than
older FFT data. You specify the weighting factor to apply, which either increases or
decreases the effect of the new FFT data on the average. This is a continuous averaging
mode.

— PeakHold - With PeakHold averaging, each new FFI data point is compared with the
current FFT data point, and the highest amplitude (peaks) from each FFT are retained.
This is a continuous operation that combines the results of several measurements into
a final FFT measurement.

e Weighting Factor — If you choose Exponential as the spectral averaging type, enter the
weighting factor to apply. The weighting factor either increases or decreases the effect of
new FFT data on the resultant average using on the following formula:

Result = (New FFT Data) * Weighting Factor) + (Old Average * (1 — Weighting Factor))
Based on the information that you enter, the software configures the hardware and displays
the following configuration settings used by the device:

¢ The actual sample rate used by the device.
¢ The actual sample interval used by the device.
e The actual number of scans to acquire.

e The actual number of FFTs to calculate.
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Trigger Settings

[
| Recording | Trigger |

Trigger source:
| Analog Threshold Fos |

Threshold Trigger Options

Threshold value -
1.00 v

Type
@ Hardware
) Software

Channel:

Master. Ain 0

Ratio of pre/post
trigger data to analyze

Pre: 107 Past: 50%

The trigger source starts acquisition on the instrument module. In multiple device
configurations, this is the trigger source that starts acquisition on the master instrument

module.

The following trigger sources are supported:

¢ IMMediate — A software trigger event occurs immediately when you start acquisition.

¢ External TTL Pos Edge — An external digital (TTL) trigger event occurs when the device
detects a rising-edge transition on the signal connected to the Trigger In input. This
trigger provides a threshold voltage of 2 V with 0.5 V of hysteresis.

* Analog Threshold Pos Edge — A positive edge, analog threshold trigger event. When you
choose the analog threshold trigger source, the following additional options are available:

— Threshold Value - Enter the user-specified threshold value. If you select a Hardware
trigger type, enter a value between 0.2 V and 9.8 V as the threshold value. If you select
a Software trigger type, select the appropriate threshold value for that input type.

— Type - If you select Hardware, the threshold event occurs when the signal attached to
analog input channel 1 on the master instrument module rises above the user-specified
threshold (with 0.1 V of hysteresis).

If you select Software, you can select any of the channels as the input trigger source.
The threshold event occurs when the signal attached to this input channel rises above
the user-specified threshold value.
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— Ratio of pre/post trigger data to analyze — If you select a Software trigger type, you
can specify how much data to analyze before the threshold trigger occurs (pre-trigger
data) and how much data to analyze after the threshold trigger occurs (post-trigger

data) by using the slider bar.

e LXIO0 to LXI5 — An LXI trigger on the Trigger Bus. (This trigger source applies to the
master instrument module only.)

* LANO to LAN7 - A LAN trigger event.

Start acquisition by clicking the Start button from the main window or, from the Acquisition

menu, by selecting Start.

You can display the data in the Chart Recorder provided in the main window, or as numerical

data using the Channel Overview window.

Chart Recorder

The Chart Recorder allows you to log data to disk and display data from the channels that you
enabled. You can choose to display data from a subset of the enabled channels. The Chart
Recorder shows data only from the set of channels that are being recorded to memory.

Note that you collapse or expand the view of the Chart Recorder using the EH button on the

main window.

T | B2~ R & B& )|

3.100000 3.150000 3200000 3250000 3.300000 3.350000 3.400000 3450000 3.500000 3.550000 3.600000 3.650000 3.700000 3.750000 3.800000 3.850000 3.500000 3.950000 4.000000 4.050000

Master Ain 0

- E wuwwmwnwwnwvmw\wmmww

3.100000 3.150000 3200000 3250000 3.300000 3.350000 3.400000 3450000 3.500000 3.550000
Slave.Ain 0

7] Link Time Series Data

g A f“ly H\‘ If“ 4"\ a”‘ A H ‘il“h i \“ y,f“ l‘||" V¢|‘| ‘H\‘ tlm m,\ W l‘lh\ dll"W‘|}\"\F“‘NWI'|| li‘|l» 1UI "m [
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Channel Name

The Chart Recorder shows the names of the channels that you enabled when you configured
the DT8837 instrument module. Only data from the list of enabled channels is recorded to
memory. (Use the Save chart control to save the recorded data to disk.)

Channel Visibility

For each enabled channel listed under the Channel Name column, you can control which
channels are displayed using the Visible checkbox. If a box is checked under the Visible
column, a graph for the associated channel is displayed in the Chart Recorder. If a box under
the Visible column is unchecked, the graph for the associated channel is not displayed in the
Chart Recorder.

Note: Data for all enabled channels is recorded to memory regardless of whether the
channel is visible in the Chart Recorder.

For convenience, you can also make all channels visible at once by checking the Visible
checkbox under the channel configuration section of this page, and then clicking the All
button. If you do not want any of the channels to be visible, clear the Visible checkbox under
the channel configuration section of this page, and then click the All button.

Show Cursor

You can choose to display a data cursor for each of the enabled channels using the Show
Cursor column. If a box is checked under the Show Cursor column, a data cursor for the
associated channel is displayed in the Chart Recorder. If a box under the Show Cursor column
is unchecked, a data cursor for the associated channel is not displayed in the Chart Recorder.

For convenience, you can also display the data cursor for all channels at once by checking the
Cursor checkbox under the channel configuration section of this page, and then clicking the
All button. If you do not want to display the data cursor on any channel, clear the Cursor
checkbox under the channel configuration section of this page, and then click the All button.

You can enable the capability of moving the data cursor using the data-cursor chart control.
Various options are available for changing the cursor style, line style, and cursor color. Refer
to the online help for more information.

Signal Group

You can choose to display multiple signals in the same band by assigning the same Signal
Group letter to them. For each signal in the time domain, you can specify one of the following
values for the Signal Group: None, A, B, C, D, E, or F. Likewise, you can specify one of these
values for the signals in the frequency domain. If you specify None, the signal is displayed in
its own band.
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For example, to see the data from analog input signals 1 and 2 (in the time domain) in the
same band, you could set the Signal Group for both channels to letter A.

If two channels have a different plot data type (that is, one is voltage and the other is a sensor),
two Y-axes are displayed for the band. Note that the Signal Group letter is shown in the
legend beneath the x-axis:
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4.500000 4.600000 4.700000
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Data Tab

The Data tab options allow you to select the units in which the data is plotted in the Chart
Recorder and Channel Overview windows.

The choices vary depending on the channel type selected under the Channel Names:

¢ Analog input and output channels — You can choose either Voltage (the default choice) to
plot the voltage data unaltered, or Sensor if you want to specify a linear conversion to
change the voltage to a sensor value, such as acceleration.

If you select Sensor, enter the Unit in which to display the data (such as V or g), the
number of millivolts per unit (mV/Unit) by which to scale the raw voltage, and an Offset
value to add to the scaled signal.

* Tachometer channels — Choose RPM if you want to plot the data from the tachometer in
RPMs. When you select this option, enter values in the Device Ticks Per Revolution and
Device Max RPM fields for your particular tachometer. The application can then calibrate
to the characteristics of your tachometer and yield a meaningful result.

Choose Time if you want to plot the data from the tachometer in seconds. You can enter
the maximum value for the Y axis in the Maximum expected time field.

Choose Freq if you want to plot the data from the tachometer in Hertz. You can enter the
maximum value for the Y axis in the Maximum expected frequency field.
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Counter/timer channels — Choose Time if you want to plot the data from the
counter/timer in seconds. You can enter the maximum value for the Y axis in the
Maximum expected time field.

Choose Freq if you want to plot the data from the counter/timer in Hertz. You can enter
the maximum value for the Y axis in the Maximum expected frequency field.

Plot Tab

The Plot tab, along with the Style tab, allows you to control how the plots look in the Chart
Recorder window. You can change the following attributes of the Chart Recorder using the
Plot tab:

For the Plot update rate, enter a value between 1 and 50 to indicate how often you want
the display to be refreshed per second.

You can adjust how the plot scrolls to the left using the Smooth scrolling checkbox. If
Smooth scrolling is checked, the plot attempts to scroll after each data point is added.
However, scrolling is limited by the actual update rate. For example, if the Plot update
rate is set to 50, and 100 points are added per second (determined by the Recording
settings), the plot scrolls to the left by 2 samples, 50 times per second.

If the Smooth scrolling checkbox is unchecked, the plot does not attempt to scroll after
every point is added; instead, it scrolls after each buffer is plotted. The buffer size is set to
the FFT size.

In the Chart Header Text box, enter the text that you want to display at the top of the
Chart Recorder.

Under Time domain X axis units, select the units for the x-axis as either the number of
samples (0 to the maximum number of samples acquired) or the relative time (0 to the
total recording time).

Style Tab

The Style tab, along with the Plot tab, allows you to control how the plots look in the Chart
Recorder window. You can change the following attributes of the Chart Recorder using the
Plot tab:

Use the Current trace color drop-down box to choose a different color for the trace on the
Chart Recorder for the currently selected channel.

Use the Background color drop-down box to choose a different color for the background
of the Chart Recorder.

Use the Foreground color drop-down box to choose a different color for the foreground
(axes and label text) of the Chart Recorder.

Use the Grid line color drop-down box to choose a different color for the grid lines of the
Chart Recorder.

In the Trace thickness box, enter the value between 1 and 5 to set the thickness of the line
used by the trace on the Chart Recorder.
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FFTs

If the FFT averaging type is None, you can use the FFT Number box to scroll through the FFIs
that were done for the corresponding analog input channel once data is acquired. For
example, if 10 FFTs were done for the analog input channels, and you are interested in looking
at FFT number 4, set the FFT number to 4 and the plot for that FFT is displayed in the Chart
Recorder.

If you want to see the actual analog input data that corresponds to a particular FFT number,
click the Link Time Series Data checkbox. The data plot for the corresponding analog input
channels is then displayed for the selected FFT number.

Chart Controls

The toolbar of the Chart Recorder provides a number of controls for viewing the data
(including scrolling and zooming), as well as printing and saving the data.

Refer to the online help for more information about using the controls provided with the
Chart Recorder.

Device Status

The status of the device is shown at the bottom of the Chart Recorder.

Channel Overview

The Channel Overview displays the data from your instrument modules in numerical form.
Open the Channel Overview by selecting the button on the Main screen.
The Channel Overview screen is displayed.

ey ] p——

Channel Display Enable Master.Ain 0 Master.Tach 0 Slave.Ain 0 Slave.Gate Counter

=L Il -.00%0 v 60.5233 RPM 0166 g .0050 Sec

Master.Tach 0 3
Slave.Ain 0 -

Data Reduction Method

— First Value

—| — Average
— Min
— Max

Display Update Rate
| J Slow

[ Keep ontap

1. Select the channels that you want to be visible on the right side of the window by clicking
to the right of the green channel indicator. You configure the channel names using the
Change Configuration menu option.
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If display is enabled, the channel indicator is bright green; if display is disabled, the
channel indicator is dark green.

. You can select from the following data reduction methods:
— First value — Displays the first value in the buffer for each of the selected channels.

— Average — Displays the average value in the buffer for each of the selected channels
(this is the default value).

— Min - Displays the minimum value in the buffer for each of the selected channels.
— Max - Displays the maximum value in the buffer for each of the selected channels.

. Choose how fast you want the Channel Overview display to be updated. Slide the bar to
the left for faster update rates, or slide the bar to the right for slower update rates.

. If you want the Channel Overview window to appear on top of the other windows of the
VIBpoint Framework application, click the Keep on top checkbox. If this box is
unchecked, the window will appear behind the other windows of the VIBpoint
Framework application.

If you move or resize the Channel Overview window, the application remembers this
information and displays the window in the same location the next time you open the
application.
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Exiting from the VIBpoint Framework Application

When you are finished using the VIBpoint Framework application, exit from the application
by selecting the File menu and clicking Exit.
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General Checklist

Should you experience problems using a DT8837 instrument module, do the following:

1.

Read all the documentation provided for your product. Make sure that you have added
any “Read This First” information to your manual and that you have used this
information.

Check the DT8837 CD for any README files and ensure that you have used the latest
installation and configuration information available.

Check that your system meets the requirements as stated in the README file on the
DT8837 CD.

Check that you have installed your hardware properly using the instructions in Chapter
3.

Check that you have wired your signals properly using the instructions in Chapter 4.

Check that you have installed Java and configured your web browser appropriately using
the instructions on page 47.

Search the DT Knowledgebase in the Support section of the Data Translation web site (at
www.datatranslation.com) for an answer to your problem.

If you still experience problems, try using the information in Table 5 to isolate and solve the
problem. If you cannot identify the problem, refer to page 116.

Table 5: Troubleshooting Problems

Symptom Possible Cause Possible Solution
DT8837isnot | The DT8837 cannot Ensure that your DT8837 is properly connected; see the instructions
found. communicate with the in Chapter 3.
network.

If your PC has a static IP address, reconfigure it for Auto-IP using
the instructions on page 144.

Check your DT8837 LAN configuration; see the instructions on
page 56.

Check the IP address of the instrument module by opening a
Command Prompt window (Start -> Programs -> Accessories ->
Command Prompt) and entering the command

"ipconfig /all". The IP settings of your instrument module are
returned.

Ping the instrument module by opening a Command Prompt window
(Start -> Programs -> Accessories -> Command Prompt) and
entering the command "ping address", where address is the IP
address of your instrument module. If a timeout message is
returned, the IP address is incorrect. If a "no host" error message is
returned, the subnet mask is incorrect. Refer to Appendix C for more
information on IP and subnet addresses.

If needed, reset the instrument module using the instructions on
page 33.
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Table 5: Troubleshooting Problems (cont.)

Symptom Possible Cause Possible Solution
DT8837 does | The DT8837 Check your DT8837 LAN configuration; see the instructions on
not respond. configuration is page 56.
incorrect.

Check the IP address of the instrument module by opening a
Command Prompt window (Start -> Programs -> Accessories ->
Command Prompt) and entering the command "ipconfig /all". The IP
settings of your instrument module are returned.

Ping the instrument module by opening a Command Prompt window
(Start -> Programs -> Accessories -> Command Prompt) and
entering the command "ping address", where address is the IP
address of your instrument module. If a timeout message is
returned, the IP address is incorrect. If a "no host" error message is
returned, the subnet mask is incorrect. Refer to Appendix C for more
information on IP and subnet addresses.

If needed, reset the instrument module using the instructions on

page 33.
The DT8837 is Contact Data Translation for technical support; refer to page 117.
damaged.
Intermittent Loose connections or Check your wiring and tighten any loose connections or cushion
operation. vibrations exist. vibration sources; see the instructions in Chapter 4.
The DT8837 is Check environmental and ambient temperature; consult the
overheating. specifications on page 135 of this manual and the documentation
provided by your computer manufacturer for more information.
Electrical noise exists. Check your wiring and either provide better shielding or reroute
unshielded wiring; see the instructions in Chapter 4.
Data appears | An open connection Check your wiring and fix any open connections; see the
to be invalid. exists. instructions in Chapter 4.
A transducer is not Check the transducer connections; see the instructions in
connected to the Chapter 4.

channel being read.

The channel Check your wiring and ensure that what you specify in software
configuration does not matches your hardware configuration; see the instructions in
match the software Chapter 4.

configuration for that

channel.

Your DT8837 instrument | The DT8837 instrument module is calibrated at the factory.
module may need Thereafter, yearly calibration is recommended. Contact Data
recalibration. Translation at 508-481-3700, ext. 1323 (if you are in the USA) for
information on DT8837 factory recalibration. If you are located
outside the USA, call your local distributor for information; see our
web site (www.datatranslation.com) for the name and telephone
number of your nearest distributor.
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Technical Support

If you have difficulty using a DT8837 instrument module, Data Translation’s Technical
Support Department is available to provide technical assistance.

To request technical support, go to our web site at http:/ /www.datatranslation.com and click
on the Support link.
When requesting technical support, be prepared to provide the following information:

* Your product serial number

® The hardware/software product you need help on

® The version of the CD you are using

* Your contract number, if applicable

If you are located outside the USA, contact your local distributor; see our web site
(www.datatranslation.com) for the name and telephone number of your nearest distributor.
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If Your Instrument Module Needs Factory Service

If your instrument module must be returned to Data Translation, do the following:

1. Record the instrument module’s serial number, and then contact the Customer Service
Department at (508) 481-3700, ext. 1323 (if you are in the USA) and obtain a Return
Material Authorization (RMA).

If you are located outside the USA, call your local distributor for authorization and
shipping instructions; see our web site (www.datatranslation.com) for the name and
telephone number of your nearest distributor. All return shipments to Data Translation
must be marked with the correct RMA number to ensure proper processing.

2. Using the original packing materials, if available, package the instrument module as
follows:

— Wrap the instrument module in an electrically conductive plastic material. Handle
with ground protection. A static discharge can destroy components on the instrument
module.

— Place in a secure shipping container.

3. Return the instrument module to the following address, making sure the RMA number is
visible on the outside of the box.

Customer Service Dept.
Data Translation, Inc.

100 Locke Drive
Marlboro, MA 01752-1192
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DT8837 instrument modules are calibrated at the factory and should not require calibration
for initial use. We recommend that you check and, if necessary, readjust the calibration of the
analog input and analog output circuitry on the DT8837 instrument modules every six months
using the DT8837 Calibration Utility.

This chapter describes how to calibrate the analog input and output subsystems of DT8837
instrument modules using the DT8837 Calibration Utility.



Calibration

Using the Calibration Utility

Start the DT8837 Calibration Utility as follows:
1. Click Start from the Task Bar.

2. Select Programs | Data Translation, Inc | Calibration | DT8837 Calibration Utility.
The main menu of the calibration utility appears.

3. Select the instrument module to calibrate, and then click OK.
Once the calibration utility is running, you can calibrate the analog input circuitry (either

automatically or manually), described on page 122, or the analog output circuitry of the
DT8837 instrument module, described on page 124.
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Calibrating the Analog Input Subsystem

This section describes how to use the DT8837 Calibration Utility to calibrate the analog input
subsystem of a DT8837 instrument module.

The DT8837 instrument module has separate calibration for each A /D input channel. You can
choose to calibrate either an individual channel or all channels on the instrument module.

Connecting a Precision Voltage Source

To calibrate the analog input circuitry, you need to connect an external +9.3750 V precision
voltage source to the DT8837 instrument module. Connect the precision voltage source to the
first channel you want to calibrate; for example, Analog In 1(AD Ch1).

Using the Auto-Calibration Procedure

Auto-calibration is the easiest to use and is the recommended calibration method. To
auto-calibrate the analog input subsystem, do the following:

1. Select the A/D Calibration tab of the calibration utility.

2. Choose either a single channel or all channels from the Type of Calibration drop-down
list box in the Automatic Calibration area.

3. Set the voltage supply on your selected channel to 0.000V.

4. Click the Auto Calibration Start button.
A message appears notifying you to verify that 0.000 V is applied to the channel.

5. Verify that the supplied voltage to your selected channel is 0.000 V, and then click OK.
The offset value is calibrated. When the offset calibration is complete, a message appears notifying
you to set the input voltage of the channel to +9.375 V.

6. Check that the supplied voltage to your selected channel is +9.375 V, and then click OK.
The gain value is calibrated and a completion message appears.

7. If you choose to calibrate all channels, then repeat steps 3 to 6 for all other A/D channels
on the instrument module (the calibration utility prompts you to attach the precision
voltage source to the next channel). Follow the on-screen prompts to proceed through the
rest of the channels.

Note: Atany time, you can click Restore Factory Settings to reset the A/D calibration
values to their original factory settings. This process will undo any auto or manual calibration
settings.
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Using the Manual Calibration Procedure

If you want to manually calibrate the analog input circuitry instead of auto-calibrating it, do
the following for each channel (substitute the appropriate channel number as you go):

1. Adjust the offset as follows:

a. Verify that 0.000 V is applied to AD Chl, and that A/D Channel Select is set to
Channel 1.
The current voltage reading for this channel is displayed in the A/D Value window.

b. Adjust the offset by entering values between 0 and 255 in the Offset edit box, or by
clicking the up/down buttons until the A/D Value is 0.000 V.

2. Adjust the gain as follows:

a. Verify that +9.375 V is applied to AD Chl, and that A/D Channel Select is set to
Channel 1.
The current voltage reading for this channel is displayed in the A/D Value window.

b. Adjust the gain by entering values between 0 and 255 in the Gain edit box, or by
clicking the up/down buttons until the A/D Value is 9.3750 V.

Note: Atany time, you can click Restore Factory Settings to reset the A/D calibration
values to their original factory settings. This process will undo any auto or manual calibration
settings.

Once you have finished this procedure, continue with “Calibrating the Analog Output
Subsystem.”
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Calibrating the Analog Output Subsystem

This section describes how to use the DT8837 Calibration Utility to calibrate the analog output
subsystem of a DT8837 instrument module.

To calibrate the analog output circuitry, you need to connect an external precision voltmeter to
analog output channel 1 of the DT8837 instrument module.
Do the following to calibrate the analog output circuitry:

1. Select the D/A Calibration tab of the calibration utility.

2. Connect an external precision voltmeter to Analog Output 1 (DAC Ch1l) of the DT8837
instrument module.

3. In the DAC Output Voltage box, select -9.375 V.

4. Adjust the offset by entering values between 0 and 255 in the DAC 0 Offset edit box or by
clicking the up/down buttons until the voltmeter reads -9.375 V.

5. In the DAC Output Voltage box, select 9.375 V.

6. Adjust the gain by entering values between 0 and 255 in the DAC 0 Gain edit box or by
clicking the up/down buttons until the voltmeter reads 9.375 V.

Note: Atany time, you can click Restore Factory Settings to reset the D/A calibration
values to their original factory settings. This process will undo any D/ A calibration settings.

Once you have finished this procedure, the analog output circuitry is calibrated. To close the
calibration utility, click the close box in the upper right corner of the window.
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Analog Input Specifications

Table 6 lists the specifications for the analog input subsystem on the DT8837.

Table 6: Analog Input Subsystem Specifications

Feature

DT8837 Specifications

Number of analog input channels

4, differential, simultaneous

Resolution 24 bits
Ranges and gains +10 V (gain of 1),
+1 V (gain of 10)

Gain error

Gain of 1: +0.02%

Gain of 10: +0.5%
A/D type Delta-Sigma
Maximum sample rate 52.734 kHz?
Minimum sample rate 195.3 Hz

Group delay 39/Sample Frequency
FIFO 2 M Samples, total
Pass band

at -3 dB: 0.49 x Sample Frequency

at—100 dB: 0.55 x Sample Frequency
Pass band ripple +0.005 dB
Signal/noise (typical) 106 dB
Total harmonic distortion (-0.5 dB)
using 1 kHz sine wave, sampled at 50 kHz —92 dB typical
Spurious free dynamic range (SFDR)
using a 1 kHz sine wave, sampled at
50 kHz

10 V full-scale signal (-0.5 dB): —92 dB typical

1V signal (-20 dB): —115 dB typical

100 mV signal (—40 dB): —115 dB typical

0 V signal: —118 dB typical
Data encoding Offset binary
Maximum input voltage (without damage)

Power on: +40V

Power off: +40V
Input impedance 1MQ 20 pr
Overvoltage protection (power on/off) +40V
ESD protection

Arc: 8 kV

Contact: 4 kV
Current source 4 mA




Specifications

Table 6: Analog Input Subsystem Specifications (cont.)

Feature DT8837 Specifications

Compliance voltage 24V
Current noise @ 1 kHz bandwidth 5nArms
Current source accuracy +1.0%
DC offset 1.5mV
AC coupling at -3 dB 0.1 Hz
D/A Readback in A/D Stream

A/D resolution: 16 bits

Zero error: +15 mV

Full-scale error: +0, 2%

a. The conversion rate = Sample rate * 512.

b. Cable capacitance of typically 30 pF per foot must be added.
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Analog Output Specifications
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Table 7 lists the specifications for the analog output subsystem on the DT8837 instrument
module.

Table 7: Analog Output Subsystem Specifications

Feature DT8837 Specifications
Number of analog output channels 1
Resolution 24 bits
Output range +10V
Data encoding Offset binary

OQutput current

+3 mA maximum load (10 V across 3.3 K)

FIFO 128K Samples, total
ESD protection
Arc: 8 kV
Contact: 4 kV
DC offset +1.5 mV
Gain error +0.03%
2-pole, low-pass Butterworth filter 10 kHz
Time delay (typical) 29/output frequency

Power fault and reset

Goes to 0 V +10 mV if power is removed

Total harmonic distortion (typical at 1 kHz) | 0.0015%

Internal clock output frequency x 512
Minimum sample frequency 10 kHz

Maximum sample frequency 52.734 kHz

Pass band ripple (typical +0.002 dB)

0.454 x output frequency

Pass band (typical)

0.49 x output frequency

Stop band (typical)

0.567 x output frequency
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Tachometer Input Specifications

Table 8 lists the specifications for the tachometer input on the DT8837 instrument module.

Table 8: Tachometer Input Specifications

Feature

DT8837 Specifications

Number of channels

1

Resolution

31 bits per channel

Input voltage range

+30 V

Threshold voltage

+2 V with 0.5 V hysteresis

Maximum input frequency

1 MHz

Minimum pulse width high/low (minimum amount
of time it takes a C/T to recognize an input pulse)

0.4 us

Clock frequency for tachometer measurements

12 MHz (83 ns resolution)
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Gate Input Specifications

Table 9 lists the specifications for the gate input on the DT8837 instrument module.

Table 9: Gate Input Specifications

Feature DT8837 Specifications
Signal type LVTTL
Input voltage range for gate input signal Oto5V
Maximum input frequency 1 MHz
Minimum pulse width (high/low) 0.4 ps
Rise time <20 ns
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Counter Input Specifications

Table 10 lists the specifications for the counter input on the DT8837 instrument module.

Table 10: Counter Input Specifications

Feature

DT8837 Specifications

Counter resolution

32 bits

Clock frequency for counter measurements

48 MHz (21 ns resolution)
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Digital Output Specifications

Table 11 lists the specifications for the digital output on the DT8837 instrument module.

Table 11: Digital Output Specifications

Feature DT8837 Specifications
Output type Solid state relay
Maximum voltage +30 V
Maximum current +400 mA
Maximum switching time 2ms
Adjacent output isolation 250 V (limited by connector)
Non-adjacent output isolation 500 V
Closed contact resistance 0.8 Q (maximum)

132



Specifications

Trigger Specifications

Table 12 lists the specifications for the trigger on the DT8837 instrument module.

Table 12: Trigger Specifications

Feature

DT8837 Specifications

Trigger sources
Internal software trigger:
External digital trigger:
Analog threshold trigger:
Trigger Bus:
LAN Trigger Packet:

Software-selectable
Software-selectable
Software-selectable
Software-selectable
Software-selectable

External digital trigger
Input type:
Logic family:
Input logic load:
Lower threshold:
Upper threshold:
Hysteresis:
Input sink current:

Maximum input signal:
Input configuration:

Minimum pulse width high/low:

Edge-sensitive, positive trigger
LVTTL inputs

1 LVTTL

1.1V

1.3V

02V

33 UA

1.3 us

+30 V

Pulled to ground with 100 k€2 resistor

Analog threshold trigger
Type: Positive threshold trigger on analog
input channel 0
Threshold level: +0.2t0 +9.8 V
Hysteresis: 100 mV
Trigger delay 1 conversion period maximum
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Master Oscillator Specifications

Table 13 lists the specifications for the master oscillator on the DT8837 instrument module.

Table 13: Master Oscillator Specifications

DT8837
Feature Specifications
Frequency 48 MHz
Accuracy at 25° C +30 ppm

Drift over temperature 0 to 70° C (Total) +50 ppm

Aging (first year) +5 ppm

Maximum error (first year) +85 ppm
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Power, Physical, and Environmental Specifications

Table 14 lists the power, physical, and environmental specifications for the DT8837
instrument module.

Table 14: Power, Physical, and Environmental Specifications

Feature

DT8837 Specifications

Power, +5 V

+0.30 V@ 0.5 A

Physical Dimensions
Length:
Width:
Height:
Weight:

9.319 inches (236.7 mm)
8.380 inches (212.85 mm)
1.720 inches (43.69 mm)
2.373 Ibs (1076.63 Q)

Environmental

Operating temperature range:

Storage temperature range:
Relative humidity:
Altitude:

0° Cto 55° C

—-25° Cto85° C

to 95%, noncondensing
up to 10,000 feet
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Regulatory Specifications

Table 15 lists the regulatory specifications for the DT8837 instrument module.

Table 15: Regulatory Specifications

Feature

DT8837 Specifications

Emissions (EMI)

FCC Part 15,

EN55022:1994 + A1:1995 + A2:1997
VCCI, AS/NZS 3548

Class A

Immunity

EN 61000-6-1:2001

RoHS (EU Directive 2002/95/EG)

Compliant (as of July 1st, 2006)
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Connector Specifications

Table 16 lists the connector specifications for the DT8837 instrument module.

Table 16: Connector Specifications

Feature

DT8837 Specifications

RJ45 Ethernet Connector

Bothhand part number
LU1S041C-43-LF

Input/Output Connector

Tyco part number 5747845-4

Trigger Bus Connectors

Molex part number 83619-9011
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RJ45 Ethernet Connector

Figure 26 shows the RJ45 Ethernet connector.

Contad dentification

Figure 26: RJ45 Ethernet Connector

Table 17 lists the pin assignments for the RJ45 ethernet connector on the DT8837 instrument
module.

Table 17: Pin Assignments of the RJ45 Ethernet Connector

Pin Signal Name Description
1 TXD+ Transmit Data+
2 TXD- Transmit Data—
3 RXD+ Receive Data+
4 EPWR+ Power from Switch+
5 EPWR+ Power from Switch+
6 RXD- Receive Data—
7 EPWR- Power from Switch—
8 EPWR- Power from Switch—

140



Connector Pin Assignments

Input/Output Connector

The Input/Output connector, as shown in Figure 27, is a 15-pin mini D-shell connector that is
available on the DT8837 instrument module for making tachometer, gate, and digital output
connections.

8 1
oo QCo0

15 9
o000 00

Figure 27: Input/Output Connector

Table 18 lists the pin assignments for the Input/Output connector on the DT8837 instrument

module.
Table 18: Input/Output Connector Pin Assignments
Pin Description Pin Description
1 Tachometer Input 9 Tachometer Input Return
2 Trigger In 10 Trigger In Return
3 Gate In 11 Gate In Return
4 Digital Out 0 A 12 Digital Out 0 B
5 Digital Out 1 A 13 Digital Out 1 B
6 Digital Out 2 A 14 Digital Out 2 B
7 Digital Out 3 A 15 Digital Out 3 B
8 No Connect
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Trigger Bus Connector

Figure 28 shows the Trigger Bus connector. There are two Trigger Bus connectors on each
DT8837.

1 13
CO0QOo0OQ0CO000C

14 25
Qo000 OoO00C0o0

Figure 28: Trigger Bus Connector

Table 19 lists the pin assignments for the Trigger Bus connector on the DT8837 instrument

module.
Table 19: Trigger Bus Connector Pin Assignments
Pin Description Pin Description
1 +3.3V 14 SignalOp
2 +3.3V Return 15 SignalOn
3 Signalip 16 Reserved
4 Signalin 17 Signal2p
5 GND 18 Signal2n
6 Signal3p 19 GND
7 Signal3n 20 Signal4p
8 GND 21 Signal4n
9 Signal5p 22 GND
10 Signal5n 23 Signalép
11 Reserved 24 Signalén
12 Signal7p 25 Reserved
13 Signal7n
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Configuring the PC to Use Auto-IP

To set up the DT8837 instrument module when the LAN does not support a DHCP server and
your PC is configured to use a static IP address, you must temporarily reconfigure the PC to

use Auto-IP by performing the following steps:

Note: This procedure may differ slightly depending on your computer and the version of
Windows you are using. Windows XP instructions are shown here.

1. From the Windows Start menu, click Settings, and then click Network Connections.

2. Right-click Local Area Connection, and select Properties.

- Local Area Connection Properties

General | Advanced
Connect using:

B8 Broadcom 440x 10/100 Integrated C

This connection uses the following items:

g File and Printer Sharing for Microsoft Networks -
SQOS Packet Scheduler

W
< >

Description

Transmission Cortrol Protocol/Intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected networks.

Show icon in notification area when connected
Notify me when this connection has limited or no connectivity

[ ok ][ cancel |

3. In the General tab window, double-click Internet protocol (TCP/IP).
(If a TCP/IP selection is not listed, click Install, select Protocol, click Add, select the

TCP/1IP protocol, and click Install, and repeat step 3).
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Configuring Network Settings on Your PC

Internet Protocol (TCP/IP) Properties

General |

You can get P settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator for
the appropriate |P settings.

(") Obtain an IP address automaticalty
{#) Use the following P address:

IP address: .4 .7 .1

255 255 .255. O

Subret mask:

Default gateway:

() Use the following DMS server addresses:

Prefemed DNS server:

Atemate DNS server:

[ ok [ Canesl

]

4. IMPORTANT: Write down the IP address and subnet mask that is displayed! You will
need this information later.

5. Select Obtain an IP address automatically, and then click OK.

Internet Protocol (TCP/IP) Properties

General | Atemate Coﬁﬁ.gumi.i.o.n

You can get IP settings assigned automatically i your network supports
thiz capability. Otherwise, you need to ask your networs administrator for
the appropriate |P settings.

() Obtain an IP address automatically

(") Use the following IF address:

(%) Obtain DNS server address automatically
() Use the following DNS server addresses:

[ . ]
L. ]

[ ok ][ Cancel

|

6. Select the Alternate Configuration tab, and ensure that Automatic private IP address is

selected.
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Internet Protocol (TCP/IP) Properties

General | Altemate Configuration |

If this computer is used on more than one networlk, enter the altemate |P
settings below.

(%) Mutomatic private IP address
() User corfigured

[ ok [ cancsl |

7. Renew the IP address of the computer. From the Windows Start menu, click Settings
->Network Connections -> Local Area Connection -> Support -> Repair.

Or, if you prefer to do this from the command prompt window, click Run from the
Windows Start menu, enter cmd, and click OK to bring up the command prompt window.

Then, from the command prompt window, enter:

ipconfig /renew renews the IP address
ipconfig /all checks the IP address
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Specifying a Static IP Address for your Instrument

Module

To specify a static IP address for your DT8837 instrument module, use the LAN Configuration

page of the web interface as follows:

1. From the LAN Configuration page, click Modify.

2. Specify the username as sysadmin, and specify the password (the default password is
user). You can change the password, if you desire.

3. Uncheck the checkbox called Automatic private IP address enabled.

4. Click Static.

5. Specify a static IP address for the DT8837 instrument module, so that is will be on the

same subnet as your PC:

DATA TRANSLATION®

Device information LAN configuration

Configuration Wodify

Hostname

Description

IP address assignment

Technical Support

SNTP server

Time Zone

Password

T wem e

Lxr

@ DHCP
Automatic private IP address enabled
Static
Static IP Address configuration
iy

Mask

Gateway
Primary DNS
Secondary DNS

Primary
Secondary

GMT hours

Note: Youneed a Simple Network Time Protocol (SNTP) time server on the LAN; otherwise,
you need to provide a gateway. See your network administrator for more details.
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Reconfiguring the PC to Use a Static IP Address

After you have set up your DT8837 instrument module, you can reconfigure your PC to use a
static IP address using this procedure:

1.

2
3.
4

5.

148

From the Windows Start menu, click Settings, and then click Network Connections.

. Right-click Local Area Connection, and select Properties.

In the General tab window, double-click Internet protocol (TCP/IP).

. Select Use the following IP address:, specify the static IP address and subnet mask that

was initially assigned to the PC (see page 144), and click OK.

Internet Protocol (TCP/IP) Properties

General

You can get P settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator for
the appropriate |P settings.

(") Obtain an IP address automaticalty
(®) Use the following IP address:
IP address: .4 .7 .1

Subret mask: 2565 265 2585 . 0

Default gateway:

(%) Use the following DNS server addresses:
Frefemed DMS server:

Altemate DNS server:

[ ok [ cancel |

Renew the IP address of the computer. From the Windows Start menu, click Settings
->Network Connections -> Local Area Connection -> Support -> Repair.

Or, if you prefer to do this from the command prompt window, click Run from the
Windows Start menu, enter cmd, and click OK to bring up the command prompt window.
Then, from the command prompt window, enter:

ipconfig /renew renews the IP address
ipconfig /all checks the IP address
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